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Important User Information

Solid state equipment has operational characteristics differing from those of electromechanical equipment. Safery
Guidelines for the Application, Installation and Maintenance of Solid State Controls (Publication SGI-1.1 available from
your local Rockwell Automation sales office or online at http://www.rockwellautomation.com/literature) describes
some important differences between solid state equipment and hard-wired electromechanical devices. Because of this
difference, and also because of the wide variety of uses for solid state equipment, all persons responsible for applying
this equipment must satisfy themselves that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting
from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables
and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility

or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation,
Inc. is prohibited.

Throughout this manual, when necessary we use notes to make you aware of safety considerations.

WARNING: Identifies information about practices or circumstances that can
cause an explosion in a hazardous environment, which may lead to personal
injury or death, property damage, or economic loss.

Important: Identifiesinformation that is critical for successful application and understanding of the product.

ATTENTION: Identifies information about practices or circumstances that can
lead to personal injury or death, property damage, or economic loss. Attentions
help you identify a hazard, avoid a hazard, and recognize the consequences.

Shock Hazard labels may be located on or inside the equipment (e.g.,
drive or motor) to alert people that dangerous voltage may be present.

drive or motor) to alert people that surfaces may be at dangerous
temperatures.

f Burn Hazard labels may be located on or inside the equipment (e.g.,

Allen-Bradley, Rockwell Software, and TechConnect are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.
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About This Manual

Topic Page

Conventions Used in This Manual

7
Rockwell Automation Support 7
Additional Resources 8

This manual provides information about the adapter and using it with PowerFlex
7-Class (Architecture-Class) drives or Bulletin 150 SMC Soft Starters. The
adapter can be used with other products that support a DPI™ adapter, such as the
DPI External Comms Kit (20-XCOMM-DC-BASE). See the documentation
for your product for specific information about how it works with the adapter.

cOnventions Used in Th|s The following conventions are used throughout this manual:

Manual * Parameter names are shown in the format Parameter xx - [*]. The xx
represents the parameter number. The * represents the parameter name—
for example Parameter 01 - [DPI Port].

¢ Menu commands are shown in bold type face and follow the format
Menu > Command. For example, if you read ‘ Select File > Open’, you
should click the File menu and then click the Open command.

» Thefirmware revision number (FRN) is displayed as FRN X.xxx, where
‘X' isthe mgjor revision number and ‘xxx’ isthe minor revision number.

» The screen images in this manual resulted from using the following
software:
— RSLinx® Classic software, version 2.51
— RSLogix 5000 software, version 16

Different versions of the software may have screens that vary in
appearance, and differences in procedures.

Rockwell Automation Rockwell Automation offers support services worldwide, with over 75 sales and
Sunnort support offices, over 500 authorized distributors, and over 250 authorized
PP systems integrators located through the United States alone. In addition,

Rockwell Automation representatives are in every major country in the world.

Local Product Support

Contact your local Rockwell Automation representative for the following:

» Salesand order support
» Product technical training

Rockwell Automation Publication 20COMM-UMO015B-EN-P - June 2013



Preface

*  Warranty support
* Support service agreements

Technical Product Assistance

For technical assistance, please review the information in Chapter 7,
Troubleshooting, first. If you still have problems, then access the Allen-Bradley

Technical Support website at www.ab.com/support/abdrives or contact

Rockwell Automation.

Additional Resources These documents contain additional information concerning related products
from Rockwell Automation.

Resource Description

Industrial Automation wiring and grounding guidelines, publication 1770-4.1 Provides general guidelines for installing a Rockwell

Automation industrial system.

Product certifications website, http://www.ab.com Provides declarations of conformity, certificates, and
other certification details.

Industrial Security Best Practices, publication SECUR-AT001 Provides further information and guidelines on product
and system security.

PowerFlex 7-Class DPI (Drive Peripheral Interface) Network Communication Adapter Installation | Information on the installation of PowerFlex®
Instructions, publication 20COMM-IN004 20-COMM-x Network Communication Adapters.

EtherNet/IP Media Planning and Installation Manual, ODVA publication 148 ) Information on the planning, installation, and techniques

EtherNet/IP Network Infrastructure Guidelines, ODVA publication 35 (1) used to implement an EtherNet/IP network.

Ethernet Design Considerations Reference Manual, publication ENET-RM002

Connected Components Workbench website Information on the Connected Components

http://www.ab.com/support/abdrives/webupdate/software.html, and online help Workbench™ software tool—and includes a link for free
software download.

PowerFlex 20-HIM-A3/-A5/-C3S/-C5S HIM Quick Reference, publication 20HIM-QR001 Information on the use of the PowerFlex 20-HIM-A3, 20-

HIM-A5, 20-HIM-C3S, and 20-HIM-C5S HIMs.

PowerFlex 20-HIM-A6/-C6S HIM (Human Interface Module) User Manual, publication 20HIM- | Information on the installation and use of the PowerFlex

UMO01 20-HIM-A6 and 20-HIM-C6S HIMs.

PowerFlex 70 User Manual, publication 20A-UMO001 Information on installing, programming, and technical
PowerFlex 70/700 Reference Manual, publication PFLEX-RM001 data of PowerFlex 70 and PowerFlex 70EC drives.
PowerFlex 70EC/700VC Reference Manual, publication PFLEX-RM004

PowerFlex 700 Series A User Manual, publication 20B-UM001 Information on installing, programming, and technical
PowerFlex 700 Series B User Manual, publication 20B-UM002 data of PowerFlex 700/700VC Series A and PowerFlex
PowerFlex 70/700 Reference Manual, publication PFLEX-RMO001 700VC Series B drives.

PowerFlex 70EC/700VC Reference Manual, publication PFLEX-RM004

PowerFlex 700H Installation Instructions, publication PFLEX-IN006 Information on installing, programming, and technical
PowerFlex 700H Programming Manual, publication 20C-PM001 data of PowerFlex 700H drives.
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Resource

Description

PowerFlex 700S w/Phase | Control Installation Manual (Frames 1...6), publication 20D-IN024
PowerFlex 700S w/Phase | Control Installation Manual (Frames 9 and 10), publication PFLEX-
IN00B

PowerFlex 700S w/Phase | Control User Manual (All Frame Sizes), publication 20D-UMO001
PowerFlex 700S w/Phase | Control Reference Manual, publication PFLEX-RM002

PowerFlex 700S w/Phase Il Control Installation Manual (Frames 1...6), publication 20D-IN024
PowerFlex 700S w/Phase Il Control Installation Manual (Frames 9...14), publication PFLEX-
IN00B

PowerFlex 700S w/Phase Il Control Programming Manual (All Frame Sizes), publication 20D-
PMO001

PowerFlex 700S w/Phase Il Control Reference Manual, publication PFLEX-RM003

Information on installing, programming, and technical
data of PowerFlex 700S drives.

PowerFlex 700L User Manual, publication 20L-UM001

Information on installing, programming, and technical
data of PowerFlex 700L Liquid-Cooled AC drives.

SMC Flex Smart Motor Controller User Manual, publication 150-UM008

Information on installing, programming, and technical
data of SMC Flex State Smart Motor Controller.

SMC-50 Solid-State Smart Motor Controller User Manual, publication 150-UM011

Information on installing, programming, and technical
data of SMC-50 Solid-State Smart Motor Controller.

PowerFlex Digital DC Drive User Manual, publication 20P-UM001

Information on installing, programming, and technical
data of PowerFlex Digital DC drives.

Getting Results with RSLinx Guide, publication LINX-GR001and online help (")

Information on using RSLinx Classic software.

RSLogix Emulate 5/500 Getting Results Guide, publication EMULAT-GR002 and online help

Information on how to install and navigate the RSLogix
Emulate software for ladder logic programming with
AIIen-BradIey® PLC-5% and SLC™ 500 processors.

RSLogix 500 Getting Results Guide, publication LG500-GR002 and online help (1)

Information on using RSLogix 500 software tool.

ﬁ)SLogix 5000 PIDE Autotuner Getting Results Guide, publication PIDE-GR001 and online help

Information on using RSLogix 5000 software tool.

EtherNet/IP Modules in Logix5000 Control Systems User Manual, publication ENET-UMQO01

Information on using the ControILogix® 1756-ENBT or
1756-EN2T EtherNet/IP communication modules with
your Logix5000 controller and communicating with
various devices on the EtherNet/IP network.

Enhanced and Ethernet PLC-5 Programmable Controllers User Manual, publication 1785-
UMO012

Information to help design, operate and maintain an
Enhanced and Ethernet PLC-5 programmable controller
system.

MicroLogix 1100 Programmable Controllers User Manual, publication 1763-UMO001
MicroLogix 1400 Programmable Controllers User Manual, publication 1766-UMO001

Information to install, wire, and troubleshoot the
MicroLogix™ 1100 and MicroLogix 1400 controllers
respectively.

Web Updates http://www.ab.com/support/abdrives/webupdate/

Flash Update Files, Product Help Files, Control Bar
Files, GSD Files, EDS File links, DriveTools SP / Drive
AOP Database Files, and other downloads to keep your
Allen-Bradley brand drive products up to date

(1) Use this link to the ODVA EtherNet/IP library: http://odva.org/Home/ODVATECHNOLOGIES/EtherNetIP/EtherNetIPLibrary/tabid/76/Default.aspx

Documentation can be obtained online at http://
literature.rockwellautomation.com. To order paper copies of technical
documentation, contact your local Rockwell Automation distributor or sales

representative.

To find your local Rockwell Automation distributor or sales representative, visit

http://www.rockwellautomation.com/locations.

For information such as firmware updates or answers to drive-related questions,
go to the Drives Service & Support web site at http://www.ab.com/support/
abdrives and click on the Downloads or Knowledgebase link.
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Notes:
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Chapter 1

Components

Getting Started

The adapter is intended for installation in a PowerFlex 7-Class drive or Bulletin
150 SMC soft starter and is used for network communication.

Topic

Components

Features

Compatible Products

Required Equipment

Safety Precautions

Quick Start 16
Item | Part Description
(1) Status Indicators Four status indicators that indicate the status of the DPI, the
adapter, and network connection. See Chapter 7, Troubleshooting.
® | DPI Connector A 20-pin, single-row shrouded male header. An Internal Interface
cable is connected to this connector and a connector on the drive.
(3] Ethernet Connector RJ-45 connector for the Ethernet network cable. The connector is
CAT-5 compliant to ensure reliable data transfer on 100Base-TX
Ethernet connections.
O | Web Pages Switch Enables or disables the adapter web pages. See Setting the Web
(SW4) Pages Switch on page 19.
@ | Address/mode Set IP address or DHCP/BootP mode.
switches

Rockwell Automation Publication 20C0MM-UMO015B-EN-P - July 2013
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Chapter 1 Getting Started

Features The features of the adapter include the following:
* Typical mounting in a PowerFlex 7-Class drive or SMC soft starter.
* Captive screws to secure and ground the adapter to the drive.

* Compatibility with various configuration tools to configure the adapter
and connected host drive, including the following tools:

— PowerFlex HIM (Human Interface Module) on the drive or SMC, if
available

— Connected Components Workbench software, version 1.02 or later

— DriveExplorer software, version 2.01 or later

— DriveExecutive software, version 3.01 or later

— RSLogix5000 version16 and later with Drives Add-on Profile version
4.05 and later

Additionally, you can use a BOOTP/DHCP server to configure the
network address for the adapter.

* Status indicators that report the status of the drive communications, the
adapter, and network. They are visible when the drive cover is open or closed.

* Parameter-configured I/O (Logic Command/Reference and up to four
pairs of Datalinks) to accommodate application requirements.

. Explicit Messaging support.

* Master-Slave or Peer-to-Peer hierarchy that can be configured to transmit
data to and from either a controller or another PowerFlex drive or SMC on
the network.

* User-defined fault actions to determine how the adapter and connected
PowerFlex drive respond to the following:

— 1/0O messaging communication disruptions (Comm Flt Action)
— Controllersinidle mode (Idle Flt Action)

* Wb pages, viewed by using a web browser, that show information about the
adapter, its connected host drive, and DPI devices connected to the drive.

* Configurable e-mail messaging to desired addresses when selected drive
faults occur and/or are cleared, and/or when the adapter takes a

communication or idle fault action.

* Access to any PowerFlex drive or SMC and its connected peripherals on
the network to which the adapter is connected.

* Device Level Ring (DLR) or Star Topology support with Quality of
Service (QoS) support.

12 Rockwell Automation Publication 20COMM-UMO015B-EN-P - July 2013



Getting Started ~ Chapter 1

cOmp atible Products At the time of publication, the adapter is compatible with the following products:
* PowerFlex 70/70EC drives e PowerFlex 700L drives
¢ PowerFlex 700/700VC drives * PowerFlex Digital DC drives
e PowerFlex 700H drives e DPI External Comms Kit
* PowerFlex 700S drives e SMC™50

PowerFlex 7000/7000-2 drives e SMC™Flex

Note: The adapter is not compatible with PowerFlex 750 series drives.

i i Some of the equipment that is required for use with the adapter is shipped with
equired Equipment quip q p pp
the adapter, but some you must supply yourself.

Equipment Shipped with the Adapter

When you unpack the adapter, verify that the package includes the following:
' One 20-COMM-ER EtherNet/IP adapter

@ One2.54 cm (1 in.) longand one 15.24 cm (6 in.) long Internal Interface
cable (only one cable is needed to connect the adapter to the drive; for which
cable to use, see Figure 3 - on page 2-21)

0 One PowerFlex 7-Class DPI (Drive Peripheral Interface) Network
Communication Adapter Installation Instructions, publication 20COMM-
IN004

O One LED Identification Label for use with Bulletin 150 SMC Flex and
Bulletin 700 PowerFlex drives

User-Supplied Equipment

To install and configure the adapter, you must supply the following:
O A small flathead screwdriver

Q Ethernet cable (for details, see the EtherNet/IP Media Planning and
Installation Manual, ODVA publication 148 available on the ODVA
website at http://odva.org/Home/ODVATECHNOLOGIES/
EtherNetIP/EtherNetIPLibrary/tabid/76/Default.aspx)

Q' Ethernet switch (for details, see the Ethernet Design Considerations
Reference Manual, publication ENET-RM002)

U Configuration tool, such as the following:

— PowerFlex 20-HIM-xx HIM

Rockwell Automation Publication 20COMM-UMO15B-EN-P - July 2013 13
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- Connected Components Workbench software, version 1.02 or later

Connected Components Workbench is the recommended stand-alone
software tool for use with PowerFlex drives. You can obtain a free copy

by:

e Internet download at
http://www.ab.com/support/abdrives/webupdate/software.html

* Requestinga DVD at
http://www.ab.com/onecontact/controllers/micro800/

Your local distributor may also have copies of the DVD available.

Connected Components Workbench software cannot be used to
configure SCANport-based drives or Bulletin 160 drives.

DriveExplorer software, version 2.01 or later

This software tool has been discontinued and is now available as
freeware at
hetp://www.ab.com/support/abdrives/webupdate/software.html. There
are no plans to provide future updates to this tool and the download is
being provided ‘as-is’ for users that lost their DriveExplorer CD, or need
to configure legacy products not supported by Connected Components
Workbench software.

DriveExecutive software, version 3.01 or later

A Lite version of DriveExecutive software ships with RSLogix 5000,
RSNetWorx MD, FactoryTalk AssetCentre, and IteliCENTER

software. All other versions are purchasable items:
¢ 9303-4DTEO01ENE Drive Executive software

* 9303-4DTSO01ENE DriveTools SP Suite (includes DriveExecutive
and DriveObserver software)

* 9303-4DTE2S01ENE DriveExecutive software upgrade to
DriveTools SP Suite (adds DriveObserver software)

DriveExecutive software updates (patches, and so forth) can be obtained
at http://www.ab.com/support/abdrives/webupdate/software.html. It is
highly recommended that you periodically check for and install the latest
update.

— BOOTP server, version 2.1 or higher, for network setup only
O Controller configuration software, such as RSLogix 5/500/5000

O A computer connection to the EtherNet/IP network

Rockwell Automation Publication 20COMM-UMO015B-EN-P - July 2013
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Getting Started ~ Chapter 1

S afety Precautions Please read the following safety precautions carefully.

>bB b PP

> P

ATTENTION: Risk of injury or death exists. The PowerFlex drive may
contain high voltages that can cause injury or death. Remove all power
from the PowerFlex drive or SMC, and then verify power has been
discharged before installing or removing an adapter.

ATTENTION: Risk of injury or equipment damage exists. Only personnel
familiar with drive and power products and the associated machinery
should plan or implement the installation, start up, configuration, and
subsequent maintenance of the product using an adapter. Failure to comply
may result in injury and/or equipment damage.

ATTENTION: Risk of equipment damage exists. The adapter contains
electrostatic discharge (ESD) sensitive parts that can be damaged if you do
not follow ESD control procedures. Static control precautions are required
when handling the adapter. If you are unfamiliar with static control
procedures, see Guarding Against Electrostatic Damage, publication 8000-
452.

ATTENTION: Risk of injury or equipment damage exists. If the adapter is
transmitting control |/0 to the drive, the drive may fault when you reset the
adapter. Determine how your drive will respond before resetting an
adapter.

ATTENTION: Risk of injury or equipment damage exists. Parameters 21 -
[Comm Fit Action], 24 - [Idle FIt Action], and 43 - [Peer Fit Action] let
you determine the action of the adapter and connected drive if
communication is disrupted or the controller is idle. By default, these
parameters fault the drive. You may configure these parameters so that the
drive continues to run, however, precautions should be taken to ensure that
the settings of these parameters do not create a risk of injury or equipment
damage. When commissioning the drive, verify that your system responds
correctly to various situations (for example, a disconnected cable or a
controller in idle state).

ATTENTION: Risk of injury or equipment damage exists. When a system is
configured for the first time, there may be unintended or incorrect machine
motion. Disconnect the motor from the machine or process during initial
system testing.

ATTENTION: Risk of injury or equipment damage exists. The examples in
this publication are intended solely for purposes of example. There are
many variables and requirements with any application. Rockwell
Automation, Inc. does not assume responsibility or liability (to include
intellectual property liability) for actual use of the examples shown in this
publication.

Rockwell Automation Publication 20COMM-UMO015B-EN-P - July 2013
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Chapter 1 Getting Started
Quick Start This section is provided to help experienced users quickly start using the adapter.
If you are unsure how to complete a step, refer to the referenced chapter.
Step | Action See
1 Review the safety precautions for the drive or SMC Drive or SMC User
Manual
2 Review the safety precautions for the adapter Throughout this manual
3 Verify that the power control device is properly installed. Drive or SMC User
Manual
4 Install the adapter. PowerFlex 7-Class DPI
Network Communication

a. Verify that the power control device is not powered.

b. Connect the adapter to the device with the Internal Interface
cable.

c. Use the captive screws to secure and ground the adapter to
the device.

d. Connect the adapter to the network with an Ethernet cable.

NOTE: When installing the adapter in the DPI External Comms
Kit—see the 20-XCOMM-DC-BASE Installation Instructions,
publication 20COMM-IN001, supplied with the kit.

Adapter Installation
Instructions, publication
20COMM-IN004, and

Chapter 2,
Installing the Adapter

5 Apply power to the adapter. Chapter 2,
a. Verify that the adapter is installed correctly. Installing the Adapter
b. The adapter receives power from the drive or SMC. Apply
power to the device.
The status indicators should be green. If they flash red, there
is a problem. See Chapter 7, Troubleshooting.
¢. Configure and verify key drive or SMC parameters.
6 Configure the adapter for your application. Chapter 3,
Set adapter parameters for the following functions as required by Confiquring the Adapter
your application:
e |P address, subnet mask, and gateway address
e Datarate
e |/0 configuration
e Master-Slave or Peer-to-Peer hierarchy
e Fault actions
7 Configure the controller to communicate with the adapter. Chapter 4,
Use a controller configuration tool, such as RSLogix software, to | Configuring the /0
configure the master on the network to recognize the adapter and
drive or SMC.
8 Create a ladder logic program. Chapter 5,
Use a controller configuration tool, such as RSLogix software, to Using the /O
create a ladder logic program that enables you to do the Chapter 6,
following: Using Explicit
Messaging

e Control the connected device, via the adapter, by using /0.
¢ Monitor or configure the device or SMC by using explicit
messages.
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Chapter 2

Installing the Adapter

This chapter provides instructions for installing the adapter in a PowerFlex 7-

Class drive.
Topic Page
Preparing for an Installation 18
Setting the Web Pages Switch 19
Connecting the Adapter to the Drive or SMC 20
Connecting the Adapter to the Network 23
Applying Power 24
Commissioning the Adapter 26
EMc cOnfO rmance For all PowerFlex 70 and 700 drive installations that require CE conformance per

EN61800-3, a ferrite core must be installed on each EtherNet/IP cable connected
to the drive.

These ferrites are not required for installation on SMC products.

A ferrite core such as FAIR-RITE part number 2643803802 needs to be installed
according to the following diagram.

Note: the cable is wrapped 4 times around each core.

Figure 1 - Ferrite Core Installation
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Preparing for an

Installation

18

Before installing the adapter, do the following:

* Make sure the Ethernet switch is the correct type. A ‘managed’ switch that

supports IGMP snooping is usually recommended. An ‘unmanaged’
switch can be used instead if RSLogix 5000 software, version 18.00 or
later, is used and all devices on the network are configured for ‘unicast’
I/O. For more details, see the following documents:

— EtherNet/IP Media Planning and Installation Manual,
ODVA publication 148

— FEtherNet/IP Network Infrastructure Guidelines,
ODVA publication 35

— Ethernet Design Considerations Reference Manual,
publication ENET-RM002

Understand IGMP Snooping/Ethernet Switches

The 20-COMM-ER adapter is a multicast device. In most situations, an
IGMP snooping (managed) switch is required. If more than one or two
20-COMM-ER adapters are connected to the switch, a managed switch is
required—otherwise the drive may fault on a DPI Port x network loss. The
20-COMM-ER, RSLogix 5000 software, version 18.00 or later, and a
ControlLogix or CompactLogix controller will support unicast. Unicast
setup is required when adding the drive to the I/O. When all adapters are
set up as unicast devices, then an IGMP snooping (managed) switch is not

needed.

Much of EtherNet/IP implicit (I/O) messaging uses IP multicast to
distribute I/O control data, which is consistent with the CIP producer/
consumer model. Historically, most switches have treated multicast
packets the same as broadcast packets. That is, all multicast packets are re-
transmitted to all ports.

IGMP snooping constrains the flooding of multicast traffic by dynamically
configuring switch ports so that multicast traffic is forwarded only to ports
associated with a particular IP multicast group.

Switches that support IGMP snooping (managed switches) learn’ which
ports have devices that are part of a particular multicast group and only
forward the multicast packets to the ports that are part of the multicast

group.

Be careful as to what level of support a switch has of IGMP snooping.
Some layer 2 switches that support IGMP snooping require a router
(which could be a layer 3 switch) to send out IGMP polls to learn what
devices are part of the multicast group. Some layer 2 switches can use
IGMP snooping without a router sending polls. If your control system is a
standalone network or is required to continue performing if the router is
out of service, make sure the switch you are using supports IGMP
snooping without a router being present.
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Setting the Web Pages
Switch

* See Appendix A for the number of CIP connections supported by the 20-
COMM-ER adapter.

*  Verify that you have all required equipment. See Required Equipment on

page 13.

To use the adapter web pages, the Web Pages Switch must be set to its ‘Enable
Web’ position. For information to enable or disable web pages for an adapter, see
Setting Web Access Control on page 42.

electrostatic discharge (ESD) sensitive parts that can be damaged if you do
not follow ESD control procedures. Static control precautions are required
when handling the adapter. If you are unfamiliar with static control
procedures, see Guarding Against Electrostatic Damage, publication 8000-
452.

c ATTENTION: Risk of equipment damage exists. The adapter contains

Important: A new switch setting is recognized only when power is applied
to the adapter, or the adapter isreset. If you change a switch
setting, cycle power or reset the adapter to apply the change.

Set the Web Pages Switch (SW4 in Figure 2) to enable or disable the adapter web
pages. By default, the adapter web pages are disabled. For complete details on
adapter web pages, see Viewing the Adapter Web Pages on page 153.

Figure 2 - Setting Web Pages Switch (only Series B Adapter)

Web Pages
Switch

Up Position=
Disable

Down Position =
Enable

Setting Description

Down (OFF) position Web server enabled

Up (ON) position Web server disabled (as shipped)
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the Drive or SMC may contain high voltages that can cause injury or death. Remove ALL
power from the drive or SMC, and then verify power has been discharged
before installing or remaving the adapter.

CO““eCting the Adapter to 2 ATTENTION: Risk of injury or death exists. The PowerFlex drive or SMC

Remove ALL power from the drive or SMC.
Use static control precautions.

Remove the drive or SMC cover or open the drive door.

LA S M

Connect the Internal Interface cable to the DPI port on the drive and then
to the DPI connector on the adapter (see Figure 3).

5. Secure and ground the adapter to the drive or SMC (see Figure 4) by doing
the following:

— On aPowerFlex 70 drive, fold the Internal Interface cable behind the
adapter and mount the adapter on the drive using the four captive
SCrews.

— Onan SMC Flex, put the wire lug between the mounting screw and
20-COMM-ER board

Important: Tighten all screws to properly ground the adapter.
Recommended torque is 0.9 Nem (8.0 Ibein).
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Figure 3 - DPI Ports and Internal Interface Cables

20-COMM-ER Adapter (———

PowerFlex 70 - All Frames

AR

0
[
gL

' H
: '
' i
' i
! 1
i :
' i
: :
[ — S

PowerFlex 700 Frames 0 and 1 PowerFlex 700 Frames 2 and Larger SMC Flex
PowerFlex 700S Frames 0 and 1 PowerFlex 700S Frames 2 through 6

HIM panel opens to Plgce ground
wire tab
o e _allow access to DPI hetween
. interface. To open panel, mounting
;| remove screws on left screw and

side of HIM panel and

o ﬂi swing open.

circuit board

PowerFlex 700H Frames 9 and Larger

Item | Description

(1] 15.24 cm (6 in.) Internal Interface cable

DPI Connector

Ethernet cable

o oo

2.54 ¢m (1in.) Internal Interface cable
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Figure 4 - Mounting and Grounding the Adapter

Drive
0.9 Nem (8.0 ﬁ
|bein) 4 Places Adapter
@ Internal Interface Cable
T folded behind the adapter
and in front of the drive.

Ground Tab Detail

PowerFlex 70 - All Frame Sizes
(Adapter mounts in drive.)

(8.0 Ibein)

Verify metal ground tab is bent 90° and
is under the adapter before tightening
screw. After tightening the screw,
verify continuity exists between the
head of the screw and drive ground.

PowerFlex 700 Frames 0 and 1 PowerFlex 700 Frames 2 and Larger
PowerFlex 700S Frames 0 and 1 PowerFlex 700S Frames 2 through 6
(Adapter mounts on door.) (Adapter mounts in drive.)

Ground Tab Detail

0.9 Nem

(8.0 Ibein)

4 Places
le Verify metal ground tab is bent 90° and is under
o g the adapter before tightening screw. After

tightening the screw, verify continuity exists
between the head of the screw and drive ground.

PowerFlex 700H Frames 9 and Larger
PowerFlex 700S Frames 9 and Larger
(Adapter mounts behind HIM panel.)
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Connecting the Adapter to
the Network

ATTENTION: Risk of injury or death exists. The PowerFlex drive may

A contain high voltages that can cause injury or death. Remove power from
the drive, and then verify power has been discharged before installing or
removing the adapter.

1. Remove power from the drive.
2. Use static control precautions.

3. Connect one end of an Ethernet cable to the network. See Figure 5 for an
example of wiring to an EtherNet/IP network.

Figure 5 - Connecting the Ethernet Cable in a Linear Topology Network

Drive or SMC™
Controller (with 20-COMM-ER Option Modules)
(ControlLogix controller
shown with 1756-EN2TR Bridge)
To other 5
EtherNet/IP fp— e
networks ===
: ! 7HH:;
. d ¢

Computer with
Ethernet Connection

Ethernet
Switch

M The option module’s ENET1 and
ENET2 network ports are used.

Figure 6 - Connecting the Ethernet Cable in a DLR Topology Network

To other Drive or SMC™)
EtherNet/IP (with 20-COMM-ER Option Modules)
networks Controller

(ControlLogix controller
shown with 1756-EN2TR Bridge)

1783-ETAP |2

I

Q

(3

Computer with

1783-ETAP Ethernet Connection

M The option module’s ENETT and
ENET2 network ports are used.

4. For Linear or DLR Network Topology, route the other end of the Ethernet
cable from the network through the bottom of the first drive, and insert its
cable plug into the option module ENET1 network port.
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To connect to the second drive, attach another Ethernet cable between
the first drive’s option module ENET2 network port and the second
drive’s option module ENET1 network port.

To connect additional drives, repeat these daisy-chain connections in
the same way.

5. Route the other end of the Ethernet cable through the bottom of the
PowerFlex drive (Figure 4) and insert its Ethernet cable plug into the mating
adapter receptacle.

Unpredictable operation may occur if you fail to verify that parameter
settings are compatible with your application. Verify that settings are
compatible with your application before applying power to the drive.

APP'V'“Q POWEI‘ c ATTENTION: Risk of equipment damage, injury, or death exists.

Install the device cover or close the drive door, and apply power to the device. The
adapter receives its power from the connected device. When you apply power to
the adapter for the first time, its topmost PORT status indicator should be steady
green or flashing green after an initialization. If it is red, there is a problem. See

Chapter 7, Troubleshooting,

Start-Up Status Indications

After power has been applied, the status indicators for the device and
communications adapter can be viewed on the front of the device
(Eigure 7). Possible start-up status indications are shown in Table 1.

Figure 7 - Drive and Adapter Status Indicators (location will vary by device)

PS
NS

Ls2

o0 o0Ooo

[eleleole)e]

[eleolelele]
[e)eolelele]
[eoleoleolele]
[eoleoleolele]

@ Allen-Bradley
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Table 1 - Drive and Adapter Start-Up Status Indications

Iltem | Name Color | State Description
Drive STS Indicator
(1] STS (Status) | Green | Flashing Device ready but not running, and no faults are present.
(r)erfgrwtl%drive Steady Device running, no faults are present.
manual for | Yellow | Flashing, An inhibit condition exists — the drive cannot be started. Check device Parameter 214 - [Start
status device stopped | Inhibits].
:ﬂgﬁﬁgn) Flaghing, _ An intermittent type 1 alarm condition is occurring. Check device Parameter 211 - [Drive Alarm 1].
device running
Steady, A continuous type 1 alarm condition exists. Check device Parameter 211 - [Drive Alarm 1].
device running
Red Flashing A fault has occurred.
Steady A non-resettable fault has occurred.
(2] PS Off Steady No power
Orange | Flashing Requesting DPI I/0 Connections
Steady Peripheral is Connected to an incompatible product or no DPI ping events are detected.
Green | Flashing Normal Operation (DPI connected) - No I/O, or PLC in Program
Steady Normal Operation (DPI connected) - /O Operational
Red Flashing DPI Problem, Bad CRC of Adapter Parameters or Flash Program
Steady DPI Failure or Failed power-on diagnostic test (hardware failure)
Green/ | Flashing Flash update in progress
Red
NS Off Steady No power OR no IP Address
Green | Flashing An IP address is configured, but no CIP connections are established, and an Exclusive Owner
connection has not timed out
Steady At least one CIP connection (any transport class) is established, and an Exclusive Owner
connection has not timed out
Red Flashing Connection has timed out see the “The EtherNet Adaptation of CIP” Specification sections 9-4.4
for detailed behavior description
Steady Duplicate IP Address detected
Orange | Steady Adapter Failure (used in conjunction with PS orange)
Green/ | Flashing Self-test on power up
Red
LS1 Off Steady No Network Activity
Green | Flashing Network activity at 100 Mbps
Yellow | Flashing Network activity at 10 Mbps
LS2 Off Steady No Network Activity
Green | Flashing Network activity at 100 Mbps
Yellow | Flashing Network activity at 10 Mbps

After verifying correct operation, close or install the drive cover. For more details
on status indicator operation, see page 144 and page 145.
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Commissioning the Adapter

Configuring and Verifying Key Drive Parameters

The PowerFlex 7-Class drive can be separately configured for the control and
Reference functions in various combinations. For example, you could set the drive
to have its control come from a peripheral or terminal block with the Reference
coming from the network. Or you could set the drive to have its control come
from the network with the Reference coming from another peripheral or
terminal block. Or you could set the drive to have both its control and Reference
come from the network.

The following steps in this section assume that the drive will receive the Logic
Command and Reference from the network.

1. Use drive Parameter 090 - [Speed Ref A Sel] to set the drive speed
Reference to 22’ (DPI Port 5).

2. Ifhard-wired discrete digital inputs are not used to control the drive, verify
that unused digital input drive Parameters 361 - [Dig Inl Sel] and 362 -
[Dig In2 Sel] are set to ‘0’ (Not Used).

3. Verify that drive Parameter 213 - [Speed Ref Source] is reporting that the
source of the Reference to the drive is 22’ (DPI Port 5).

This ensures that any Reference commanded from the network can be
monitored by using drive Parameter 002 - [Commanded Speed]. If a
problem occurs, this verification step provides the diagnostic capability
to determine whether the drive/adapter or the network is the cause.

To commission the adapter, you must set a unique IP address on the network.
After installing the adapter and applying power, you can set the IP address by
usinga BOOTP/DHCP server or adapter parameters. See Setting the IP

Address, Subnet Mask, and Gateway Address on page 32 for details.

By default, the adapter is configured so that you must set the IP address using a
BOOTP/DHCP server or by setting the adapter to a valid address, 1-254, via the
rotary switches on the adapter. An invalid address 0 or >254 will cause the
module to defer to the addressing mode selected by parameter 3 [BOOTP/
DHCP]. If disabled, the adapter will use the address information stored in the
adapters database. If that address is invalid, the adapter will try to contact a
DHCP server on the network. To use adapter parameters, you must disable the
BOOTP feature. For details, see Disable the BOOTP Feature on page 32.

Important: New settings for some adapter parameters (for example,
Parameters 04 - [IP Addr Cfg 1] through 07 - [IP Addr Cfg
4]) are recognized only when power is applied to the adapter or
it isreset. After you change parameter settings, cycle power or
reset the adapter.
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Configuration Tools

Configuring the Adapter

This chapter provides instructions and information for setting the parameters in

the adapter.

Topic

Page

Configuration Tools

27

Using the PowerFlex 7-Class HIM

28

Using BOOTP

Setting the IP Address, Subnet Mask, and Gateway Address

Setting the Data Rate

Setting the I/0 Configuration

Selecting Master-Slave or Peer-to-Peer

Setting the Reference Adjustment

Setting a Fault Action

Setting Web Access Control

Resetting the Adapter

Viewing the Adapter Status Using Parameters

Updating the Adapter Firmware

For a list of parameters, see Appendix B, Adapter Parameters. For definitions of

terms in this chapter, see the .

The adapter stores parameters and other information in its own nonvolatile
storage (NVS) memory. You must, therefore, access the adapter to view and edit
its parameters. The following tools can be used to access the adapter parameters.

Tool See
PowerFlex 7-Class HIM page 28
BOOTP/DHCP server page 29

Connected Components Workbench
software, version 1.02 or later

http://www.ab.com/support/abdrives/webupdate/
software.html, or online help (installed with the software)
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Using the PowerFlex 7-
Class HIM

28

If your drive has either an LED or LCD HIM (Human Interface Module), it can
be used to access parameters in the adapter as shown below. It is recommended
that you read through the steps for your HIM before performing the sequence.
For additional information, see the drive documentation or the PowerFlex 7-

Class HIM Quick Reference, publication 20HIM-QRO0O01.

Using an LED HIM

Step

Example Screens

1.

Press the key and then the Device @3 (Sel) key to
display the Device Screen.

. Press the @9 or @ key to scroll to the adapter. Letters

represent files in the drive, and numbers represent ports. The
adapter is usually connected to port 5.

. Press the @@ (Enter) key to enter your selection. A

parameter database is constructed, and then the first
parameter is displayed.

. Edit the parameters using the same techniques that you use to

edit drive parameters.

56001

Using an LCD HIM
Step Example Screens
1. In the main menu, press the @9 or @ key to scroll to
Device Select. F-> |Stopped Auto
2. Press the @ (Enter) key to enter your selection. . Hz
Main Menu:
3. Press the @9 or @2 key to scroll to the adapter (20- Diagnostics
COMM-ER). Parameter
Device Select
4. Press the @ (Enter) key to select the adapter.
A parameter database is constructed, and then the main Port 5 Device
menu for the adapter is displayed. 20-COMM-ER
. . . Main Menu:
5. Edit the parameters using the same techniques that you use to Diagnostics

edit drive parameters.

Parameter
Device Select

NOTE: All configuration procedures throughout this chapter use the PowerFlex
7-Class LCD HIM to access parameters in the adapter and show example LCD
HIM screens.

When using a PowerFlex 20-HIM-AG or 20-HIM-C6S HIM, see its User Manual,

publication 20-HIM-UMO001.

SMC Flex controllers require an external HIM (A3 or A6) to program the
adapter. The internal Human Interface of the SMC Flex does not allow
programming of the Adapter.
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Using BOOTP

TIP

The IP address, subnet mask and gateway address can be configured multiple
ways depending on the setting of the three rotary switches on the adapter. The
switches are read on power up or reset.

1. If the switches are set to an address from 1...254, that value will be used as
the LSB of the IP address 192.168.1.xxx

2. If the switches are set to an invalid number (000 or a value greater than
254), the unit will check if DHCP is enabled. If DHCP is enabled, the
unit requests an address from a DHCP server.

If DHCP is not enabled and switches are set to an illegal value, the adapter
will use the IP address (along with other TCP configurable parameters)
stored in nonvolatile memory. If the unit finds that the stored IP
configuration is not usable (set to 0), then the unit will revert to the out-of-

box behavior of DHCP being enabled.

3. Any other switch setting will cause the adapter to use the IP address data
set in the adapter's database parameters.

By default, the adapter is configured so that you can set its IP address, subnet
mask, and gateway address by usinga BOOTP or a DHCP server. There is a
variety of BOOTP servers available. The following instructions use Rockwell
Automation’s BOOTP Server, version 2.3 or later, a free standalone program that
incorporates the functionality of standard BOOTP utilities with a graphical
interface. It is available from http://www.software.rockwell.com/support/
download/detail.cfm?ID=3390. See the Readme file and online Help for

directions and more information.

If desired, you can disable BOOTP and configure the IP address, subnet mask, and
gateway address with adapter parameters. For details, see Setting the IP Address
Subnet Mask, and Gateway Address on page 32.

Configure the Adapter Using a BOOTP Server
1. On the adapter label, note the adapter’s hardware Ethernet Address

(MAC), which will be used in step 6.

2. On acomputer connected to the EtherNet/IP network, start the BOOTP
software.
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30

The BOOTP Server window appears.

3. Select Tools > Network Settings to display the Network Settings window.

To properly configure devices on your EtherNet/IP network, you must
configure settings in the BOOTP software to match the network.

4. Edit the following:

Box

Type

Subnet Mask (1)

The subnet mask for the adapter's network.

Gateway (!

The IP address of the gateway device on the adapter’s network.

Primary DNS

The address of the primary DNS server to be used on the local end of
the link for negotiating with remote devices.

Secondary DNS

Optional — the address of the secondary DNS server to be used on the
local end of the link for negotiating with remote devices when the primary
DNS server is unavailable.

Domain Name

The text name corresponding to the numeric IP address that was
assigned to the server that controls the network.

(1) For definitions of these terms, refer to the .

5. Click OK to apply the settings.

Devices on the network issuing BOOTP requests appear in the BOOTP
Request History list.
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6. In the BOOTP Request History list, either double-click the adapter’s

Ethernet Address (MAC) noted in Step 1, or click New in the Relation
List.

The New Entry dialog box appears.

In the first case, the Ethernet Address (MAC) is automatically entered. In
the latter case, you must manually enter it.

7. Edit the following:

Box Type

IP Address A unique IP address for the adapter
Host Name Optional

Description Optional

8. Click OK to apply the settings.

The adapter appears in the Relation List with the new settings.

53 BOOTP/DHCP Server 2.3 EEox

File Tools Help

Fequest History

[hemincsec] | Type Ethemet Address [MAC) IP Address Hostname
13:31:00 00:00:BC:08:60:09 10.91.100.79 20COMMEG21A
13:20:59 00:00:BC:08:60:00
13:30:54 00:00:BC:08:60:09
13:30:51 00:00:BC:08:60:09
Relation List
Hew | |
Ethernet Address [MAL) Type IP Address Hosthame Description

00:00:BC:08:60:09 10.91.100.79 20COMMEGZ1A Bldg 6 Floor 2 Fan 1A

Status Entries:

0 of 256

9. To assign this configuration to the adapter permanently, select the device
in the Relation List and click Disable BOOTP/DHCP.

When power is cycled on the adapter, it will use the configuration you
assigned it and not issue new BOOTP requests.

TIP  Toenable BOOTP for an adapter that has had BOOTP disabled, first select the

adapter in the Relation List, then click Enable BOOTP, and lastly reset the adapter
or power cycle the drive.
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10. Select File > Save to save the Relation List.

Setu ng the IP AddreSS, By default, the adapter is configured so that you set its IP address, subnet mask,

Subnet Mask, and Gateway
Address parameters.

and gateway address usinga BOOTP/DHCP server. To use adapter parameters
instead, you must disable BOOTP/DHCP and then set the associated adapter

The IP address can be set using the rotary switches on the adapter to an address
from 1...254 that will be used as the lower byte of the IP address 192.168.1.xxx.
The Subnet mask will be set to 255.255.255.0.

If the rotary switches are set to any invalid address (0 or >254), the address
programmed in the adapter's internal data base will be used.

Disable the BOOTP Feature

1. Set the value of Parameter 03 - [BOOTP/DHCP] to ‘0’ (Disabled).

Disabled

Port 5 Device Value | Setting
20-COMM-ER 0 Disabled
Parameter #: 03 1 Enabled (Default)
BOOTP

Note: The internal port used by the adapter is different for different
products. The examples here show port 5, used by the SMC Flex and drive
products. The SMC-50 uses port 4.

2. Reset the adapter; see Resetting the Adapter on page 43.

After disabling the BOOTP/DHCP feature, you can then configure the
I P address, subnet mask, and gateway address using adapter parameters.

Set an IP Address Using Parameters

1. Verify that Parameter 03 - [BOOTP/DHCP] is set to ‘0’ (Disabled).

32 Rockwell Automation Publication 20COMM-UMOQ15B-EN-P - July 2013



Configuring the Adapter ~ Chapter 3

2. Set the value of Parameters 04 - [IP Addr Cfg 1] through 07 - [IP Addr
Cfg 4] to a unique IP address.

Port 5 Device Default=0.0.0.0 ~ 255.255.255.255
20-COMM-ER [IP Addr Cfg 1]

Parameter #: 04 [IP Addr Cfg 2]

IP Addr Cfg 1

[IP Addr Cfg 3]
0<>255 [IP Addr Cfg 4]
3. Reset the adapter; see Resetting the Adapter on page 43.

The Network status indicator will be steady green or flashing green if
the IP address is correctly configured, and is connected to an operating
ethernet network.

Set a Subnet Mask Using Parameters

1. Verify that Parameter 03 - [BOOTP/DHCP] is set to ‘0’ (Disabled).

2. Set the value of Parameters 08 - [Subnet Cfg 1] through 11 - [Subnet Cfg
4] to the desired value for the subnet mask.

Default=0.0.0.0 ~ 255.255.255.255

Port 5 Device
20-COMM-ER [Subnet Cfg 1] ‘
Parameter #: 08

fg 2
Subnet Cfg 1 [Subnet Clo 2

[Subnet Cfg 3]
0<>255 [Subnet Cfg 4]

3. Reset the adapter; see Resetting the Adapter on page 43.

Set a Gateway Address Using Parameters

1. Verify that Parameter 03 - [BOOTP] is st to ‘0’ (Disabled).

2. Set the value of Parameters 12 - [Gateway Cfg 1] through 15 - [Gateway
Cfg 4] to the IP address of the gateway device.

Default = 0.0.0.0 255.255.255.255

Port 5 Device |
20-COMM-ER [Gateway Cfg
Parameter #: 12 [Gateway Cfg 2]
Gateway Cfg 1 [Gateway Cfg 3]
0<>255 [Gateway Cfg 4]

3. Reset the adapter; see Resetting the Adapter on page 43.
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Setting the Data Rate

34

By default, the adapter is set to autodetect, so it automatically detects the data rate
and duplex setting used on the network. If you need to set a specific data rate and
duplex setting, the value of Parameter 16 - [EN P1 Rate Config] determines the
Ethernet data rate and duplex setting that the adapter will use to communicate. For
definitions of data rate and duplex, see Glossary on page 221.

1. Set the value of Parameter 16 - [EN P1 Rate Config] to the data rate at
which your network is operating.

Port 5 Device Value | Data Rate
20-COMM-ER 0 Autodetect (default)
Parameter #: 16 1 10 Mbps Full
EN P1 Rate Config 2 10 Mbps Half
Hutodetect 3 100 Mbps Full

4 100 Mbps Half

TIP  Auto detection of baud rate and duplex works properly only if the device (usually a
switch) on the other end of the cable is also set to automatically detect the baud
rate/duplex. If one device has the baud rate/duplex hard-coded, the other device
must be hard-coded to the same settings.

2. Reset the adapter; see Resetting the Adapter on page 43.

By default, the adapter is set to autodetect, so it automatically detects the data rate
and duplex setting used on the network. If you need to set a specific data rate and
duplex setting, the value of Parameter 18 - [EN P2 Rate Config] determines the
Ethernet data rate and duplex setting that the adapter will use to communicate. For
definitions of data rate and duplex, see Glossary on page 221.

1. Set the value of Parameter 18 - [ENEN P2 Rate Config] to the data rate
at which your network is operating.

Port 5 Device Value | Data Rate
20-COMM-ER 0 Autodetect (default)
Parameter #: 18 1 10 Mbps Full
EN P2 Rate Config 2 10 Mbps Half
Hutodetect 3 100 Mbps Full

4 100 Mbps Half

TIP  Auto detection of baud rate and duplex works properly only if the device (usually a
switch) on the other end of the cable is also set to automatically detect the baud
rate/duplex. If one device has the baud rate/duplex hard-coded, the other device
must be hard-coded to the same settings.

2. Reset the adapter; see Resetting the Adapter on page 43.
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Setting the 1/0
Configuration

The I/O configuration determines the data that is sent to and from the drive.
Logic Command/Status, Reference/Feedback, and Datalinks may be enabled or
disabled. (Datalinks allow you to read/write directly to parameters in the drive
using implicit I/O.) A ‘1’ enables the I/O and a ‘0’ disables the I/O.

1. Set the bits in Parameter 25 - [DPI1/0 Cfg].

Port 5 Device Bit Description
20-COMM-ER 0 Logic Command/Reference (Default)
Parameter #: 25 1 Datalink A
DPI1/O Ctg 2 Datalink B
4 Datalink D
5...15 | Not Used

Bit 0 isthe right-most bit. It is highlighted above and equals ‘1'.

2. Ifacontroller is used to control the drive, set adapter Parameters 37 - [M-
S Input] and 38 - [M-S Output] for Master-Slave Hierarchy.

For details, see Setting a M aster-Slave Hierarchy (Scanner-to-Drive
Communication) on page 36.

3. If Logic Command/Reference is enabled, configure the parameters in the
drive to accept the Logic Command and Reference from the adapter.

For example, set Parameter 90 - [ Speed Ref A Sel] in aPowerFlex 70 or
700 drive to ‘22’ (DPI Port 5) so that the drive uses the Reference from
the adapter. Also, verify that the mask parameters (for example,

Parameter 276 - [Logic Mask]) in the drive are configured to receive the
desired logic from the adapter. See the documentation for your drive for

details.

The the SMC devices do not currently use the reference data sent in the
IO frame. No reference configuration is required. Refer to the
applicable SMC user manual for the latest reference configuration

information.

4. Ifyou enabled one or more Datalinks, configure parameters in the drive to
determine the source and destination of data in the Datalink(s).

When using Datalinks, up to 8 [Data In xx] parameters and/or up to 8
[Data Out xx] parameters must be assigned to point to the appropriate
parameters for your application. See Chapter 4 for an example.

5. Reset the adapter; see Resetting the Adapter on page 43.

The adapter is ready to receive I/O. You must now configure the adapter to
receive I/O from a master or peer device. See Selecting Master-Slave or Peer-to-
DPeer. If you select a Master-Slave hierarchy, you must also configure the master to

communicate with the adapter. See Chapter 4, Configuring the I/O.
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Selecti ng Master-Slave or A hierarchy determines the type of device with which the adapter exchanges data.

Peer-to-Peer In a Master-Slave hierarchy, the adapter exchanges data with a master, such asa
scanner or bridge (1756-ENBT, 1756-EN2T, 1747-L5-xxx, and so forth). In a
Peer-to-Peer hierarchy, the adapter exchanges data with one or more EtherNet/IP
adapters in other devices. (The devices must have compatible Logic Command/
Status words.)

For both Master-Slave and Peer-to-Peer hierarchies, the devices exchanging data
must be on the same IP subnet. See ‘TP Addresses’ in the for information about
IP subnets.

Setting a Master-Slave Hierarchy (Scanner-to-Drive
Communication)

1. Enable the desired I/O in Parameter 25 - [DPI1/0O Cfg].
See Setting the I/O Configuration on page 35.
2. Set the bits in Parameter 37 - [M-S Input].

This parameter determines the data received from the master by the
device. A ‘1’ enablesthel/O and a‘0" disablesthe1/O.

Port 5 Device Bit Description
20-COMM-ER 0 Logic Command/Reference (Default)
Parameter #: 37 1 Datalink A Input
M-S Input 2 Datalink B Input
xxx oo 0 0 OBl g atalink G input
4 Datalink D Input
5...15 | Not Used

Bit O isthe right-most bit. It is highlighted above and equals*1'.
3. Set the bits in Parameter 38 - [M-S Output].

This parameter determines the data transmitted from the device to the
scanner. A ‘1" enablesthe |/O and a0’ disablesthe I/O.

Port 5 Device Bit Description
20-COMM-ER 0 Status/Feedback (Default)
Parameter #: 38 1 Datalink A Output
M-S Output 2 Datalink B Output
)ét);;(u)s(, /)lgsj(t;(kx Xxx 20% 00l 3 Datalink C Output

4 Datalink D Output

5...15 | Not Used

Bit O isthe right-most hit. It is highlighted above and equals ‘1'.

4. Reset the adapter; see Resetting the Adapter on page 43.
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The adapter is ready to receive I/O from the master (that is, scanner). You must
now configure the scanner to recognize and transmit I/O to the adapter. See

Chapter 4, Configuring the I/O.

Setting the Adapter to Transmit Peer-to-Peer Data (Drive-to-Drive

Communication)

1. Verify that Parameter 53 - [Peer Out Enable] is set to ‘0’ (Off).

This parameter must be Off while you configure peer output parameters.

Port 5 Device Value | Setting
20-COMM-ER 0 Off (Default)
Parameter #: 53 1 On

Peer Out Enable

Off

2. Set Parameter 51 - [Peer A Output] to select the source of the data to

output to the network.

Port 5 Device Value | Description

20-COMM-ER 0 Off (Default)

Parameter #: 51 1 Logic Command/Reference
Peer A Output 2..5 | Datalink A, B, C, or D Input
Cma/Ref 6...9 | Datalink A, B, C, or D Output

3. Ifdesired, set Parameter 52 - [Peer B Output] to select an additional
source of the data to output to the network.

Port 5 Device Value | Description

20-COMM-ER 0 Off (Default)

Parameter #: 52 1 Logic Command/Reference
Peer B Output 2.5 | Datalink A, B, C, or D Input
DL A Input 6...9 | Datalink A, B, C, or D Qutput

4. Set Parameters 54 - [Peer Out Time] and 55 - [Peer Out Skip] to

establish the minimum and maximum intervals between peer messages.
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Because the adapter transmits peer messages when a change-of-state
condition occurs, minimum and maximum intervals are required.

— The minimum interval ensures that the adapter does not transmit
messages on the network too often, thus minimizing network traffic.
Set it with Parameter 54 - [Peer Out Time].

— The maximum interval ensures that the adapter transmits messages
often enough so that the receiving adapter(s) can receive recent data
and verify that communications are working or, if communications
are not working, can timeout. The maximum interval is the value of
Parameter 54 - [Peer Out Time] multiplied by the value of
Parameter 55 - [Peer Out Skip].

In the example below, the minimum interval is set to 2.00 seconds
(Parameter 54 - [Peer Out Time]), and the maximum interval is set to
4.00 seconds (2.00 x ‘2’ setting of Parameter 55 - [Peer Out SKip]).

Port 5 Device
20-COMM-ER

Port 5 Device
20-COMM-ER

Parameter #: 54
Peer Out Time

Parameter #: 55
Peer Out Skip

1<>16

S
0<>10.00

Default =10.00 s

Default =1

5. Set Parameter 53 - [Peer Out Enable] to ‘1’ (On).

The adapter will transmit the data selected in Parameters 51 - [Peer A
Output] and 52 - [Peer B Output] to the network. Another adapter
must be configured to receive the peer 1/0 data.

Setting the Adapter to Receive Peer-to-Peer Data

1. Verify that Parameter 49 - [Peer Inp Enable] is set to ‘0’ (Off).

This parameter must be Off while you configure the peer input
parameters.

Port 5 Device Value | Setting
20-COMM-ER 0 Off (Default)

Parameter #: 49 1 On
Peer Inp Enable

Off

2. Set Parameters 44 - [Peer Inp Addr 1] through 47 - [Peer Inp Addr 4] to

the IP address of the node from which you want to receive data.
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Valid nodes must have 20-COMM-ER adapters connected to driveswith
compatible Logic Command/Status words.

Port 5 Device
20-COMM-ER

Parameter #: 44
Peer Inp Addr 1

0<>255

IP Address of Node
Transmitting Peer 1/O ‘

Default =0.0.0.0

255.255.255.255

[Peer Inp Addr 1]
[Peer Inp Addr 2]

[Peer Inp Addr 3]
[Peer Inp Addr 4]

3. Set Parameter 40 - [Peer A Input] to select the destination of the data that

is input to the drive as Peer A.

Port 5 Device Value | Description

20-COMM-ER 0 Off (Default)

Parameter #: 40 1 Logic Command/Reference
Peer A Input 2..5 | Datalink A, B, C, or D Input
Cmd/Ref

Data is used from the least significant word in the event of a mismatch in

Reference or Datalink sizes.

4. If desired, set Parameter 41 - [Peer B Input] to select the destination of
the data to input to the device as Peer B.

Port 5 Device Value | Description
20-COMM-ER 0 Off (Default)

Parameter #: 41 1 Logic Command/Reference
Peer B Input 2..5 | Datalink A, B, C, or D Input
DL A Input

5. Ifthe adapter receives a Logic Command, set the bits in Parameter 42 -
[Peer Cmd Mask] that the device should use.

The bit definitions for the Logic Command word will depend on the
drive to which the adapter is connected. See Appendix D or the device

documentation.

Port 5 Device Value | Description

20-COMM-ER 0 Ignore this command bit. (Default)
Parameter #: 42 1 Use this command bit.

Peer Cmd Mask

000000000000000[

Bit0 B0O

If the adapter receives a Logic Command from both a master device and a
peer device, each command bit must have only one source. The source of
command bits set to ‘0’ will be the master device. The source of command
bits set to ‘1’ will be the peer device.
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6. Resct the adapter (see Resetting the Adapter on page 43) so that changes to
Parameter 42 - [Peer Cmd Mask] take effect.

7. Set Parameter 48 - [Peer Inp Timeout] to the maximum amount of time
the adapter will wait for a message before timing out.

Important: This value must be greater than the product of Parameter
54 - [Peer Out Time] multiplied by Parameter 55 - [Peer
Out Skip] in the adapter from which you are receiving 1/0.

For example, if the value of Parameter 54 - [Peer Out Time] is 2.00
seconds and the value of Parameter 55 - [Peer Out Skip] is 2 (see
example screen in step 4 on page 37), then Parameter 48 - [Peer Inp
Timeout] needs to have a value greater than 4.00, such as 5.00 in the
example screen below.

Port 5 Device Default =10.00 s

20-COMM-ER

Parameter #: 48
Peer Inp Timeout

S
0.01 <>10.00

8. Set Parameter 43 - [Peer Flt Action] to the action that the adapter will
take if it times out.

[Peer Fit Action] lets you determine the action of the adapter and
connected device if peer communication is disrupted. By default, this
parameter faults the device. You can set this parameter so that the device
continues to run, however, precautions should be taken to ensure that the
setting of this parameter does not create a hazard of injury or equipment
damage. When commissioning the device, verify that your system responds
correctly to various situations (for example, a disconnected cable).

c ATTENTION: Risk of injury or equipment damage exists. Parameter 43 -

Port 5 Device Value | Description
20-COMM-ER 0 Fault (Default)
Parameter #: 43 1 Stop
Peer Flt Action 2 Zero Data
W 3 Hold Last

4 Send Fit Cfg

For more details, see Setting a Fault Action on page 41.

9. Set Parameter 49 - [Peer Inp Enable] to ‘1’ (On).

The adapter is now configured to receive peer I/O from the specified node.
Ensure that the specified node is configured to transmit peer I/O.
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Setting the Reference
Adjustment

Setting a Fault Action

A Reference Adjustment is a percent scaling factor for the Reference from the
network. It can be set from 0.00...200.00% to allow the drive’s Reference to either
match the network Reference (= 100.00%), scale below the network Reference
(< 100.00%), or scale above the network Reference (> 100.00%).

The SMC controllers do not currently use the reference data sent in the IO frame.
No Reference configuration is required. Refer to the applicable SMC user manual
for the latest reference configuration information.

c ATTENTION: To guard against equipment damage and/or personal injury,

note that changes to adapter Parameter 39 - [Ref Adjust] take effect
immediately. A drive receiving its Reference from the adapter will receive
the newly scaled Reference, resulting in a change of speed.

If the adapter is receiving a Reference, set Parameter 39 - [Ref Adjust] to the
desired scaling factor.

Port 5 Device Default = 100.00%

20-COMM-ER

Parameter #: 39
Ref Adjust

100.00 %
0.00 <>200.00

The adjustment takes effect as soon as it is entered.

By default, when I/O communication is disrupted (for example, a cable is
disconnected) or the controller is idle (in program mode or faulted), the drive
responds by faulting if it is using I/O from the network. You can configure a
different response to these events:

* Disrupted I/O communication by using Parameter 23 - [Comm Flt
Action]

* Anidle controller by using Parameter 24 - [Idle Flt Action]

[Comm Flt Action] and 24 - [Idle FIt Action] let you determine the action
of the adapter and connected device if I/0 communication is disrupted or
the controller is idle. By default, these parameters fault the device. You can
set these parameters so that the device continues to run, however,
precautions should be taken to ensure that the settings of these
parameters do not create a risk of injury or equipment damage. When
commissioning the device, verify that your system responds correctly to
various situations (for example, a disconnected cable or faulted controller).

c ATTENTION: Risk of injury or equipment damage exists. Parameters 23 -
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Setting Web Access
Control
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Changing the Fault Action

Set the values of Parameters 23 - [Comm Flt Action] and 24 - [Idle Flt Action]
to any of these desired responses.

Value | Action Description

0 Fault The device is faulted and stopped. (Default)

1 Stop The device is stopped, but not faulted.

2 Zero Data The device is sent 0 for output data. This does not command a stop.

3 Hold Last The device continues in its present state.

4 Send Flt Cfg | The device is sent the data that you set in the fault configuration
:):];ameters (Parameters 27 - [FIt Cfg Logic] through 36 - [FIt Cfg D2

Port 5 Device Port 5 Device
20-COMM-ER 20-COMM-ER
Parameter #: 23 Parameter #: 24
Comm Flt Action Idle FIt Action

Fault Fault

Changes to these parameters take effect immediately. A reset is not required.

If communication is disrupted and then is re-established, the drive will
automatically take commands from the network again.

Setting the Fault Configuration Parameters

If you set Parameter 23 - [Comm Flt Action] or 24 - [Idle Flt Action] to ‘Send
Flt Cfg) the values in the following parameters are sent to the drive after an I/O
communications fault and/or idle fault occurs. You must set these parameters to
values required by your application.

Parameter Description

27 - [FIt Cfg Logic] | A 16-bit value sent to the device for Logic Command.

28 - [FIt Cfg Ref] A 32-bit value (0...4294967295) sent to the device as a Reference or

29- [FIt Cfg x1 In] | D@ink.
through Important: If the device uses a 16-bit Reference or 16-bit Datalinks, the most
36 - [FIt Cfg x2In] | significant word of the value must be set to zero (0) or a fault will occur.

Changes to these parameters take effect immediately. A reset is not required.

By using a web browser to access the IP address set for the adapter, you can view
the adapter’s web pages for information about the adapter, its connected device,
and other DPI devices connected to the device, such as HIMs or converters.
Additionally, the adapter can be configured to automatically send e-mail messages
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Resetting the Adapter

to desired addresses when selected device faults occur and/or are cleared, and/or
when the adapter takes a communication or idle fault action. For more details on
the adapter’s web pages, refer to Chapter 8, Viewing the Adapter Web Pages.

By default, the adapter web pages are disabled. See Figure 2 and set the Web Pages
Switch (SW4) to the ‘Enable Web’ (up) position. Parameter 56 [ Web Enabled]
reflects the position of the web enable DIP switch on the adapter.

Important: For a change to the switch setting to take effect, the adapter
must be reset (see Resetting the Adapter on page 43).

Bit 0 of Parameter 57 - [ Web Features] is used to protect the configured settings
for e-mail messaging. By default, settings are not protected and the user can make
changes. To protect the configured settings, set the value of E-mail CfgBit 0 to ‘0’
(Disabled). You can unprotect the configuration by changing Bit 0 back to ‘I’
(Enabled). E-mail messaging will always remain active regardless of whether or
not its settings are protected—unless e-mail messaging was never configured. For
more information about configuring adapter e-mail messaging or to stop e-mail

messages, see Email Configuration Link on page 162.

Port 5 Device Bit Description
20-COMM-ER 0 E-mail Cfg (Default = 0 = Disabled)
Parameter #: 57 1...7 | Not Used

Web Features
XXXXXXXXXXXXXXX]]]
E-mail Cfg b00

Bit 0 is the right-most bit. It is highlighted above and equals ‘1",

Changes to this parameter take effect immediately. A reset is not required.

Changes to switch settings and some adapter parameters require that you reset
the adapter before the new settings take effect. You can reset the adapter by power
cycling the drive or by using Parameter 22- [Reset Module].

transmitting control I/0 to the drive, the drive may fault when you reset the
adapter. Determine how your drive will respond before resetting a
connected adapter.

c ATTENTION: Risk of injury or equipment damage exists. If the adapter is

Set Parameter 22 - [Reset Module] to ‘1’ (Reset Module).

Port 5 Device Value | Description
20-COMM-ER 0 Ready (Default)
Parameter #: 22 1 Reset Module
Reset Module 2 Set Defaults
Reset Module
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When you enter ‘1’ (Reset Module), the adapter will be immediately reset. When
you enter 2’ (Set Defaults), the adapter will set all adapter parameters to their
factory-default values. After performing a Set Defaults, enter ‘1’ (Reset Module)
so that the new values take effect. The value of this parameter will be restored to
‘0" (Ready) after the adapter is reset.

Viewing the Adapter Status The following parameters provide information about the status of the adapter.
U si“ g P aram eters You can view these parameters at any time.

Parameter Description

17 - [EN P1 Rate Act] | The data rate used on port 1 of the adapter

19 - [EN P2 Rate Act] | The data rate used on port 2 of the adapter

20 - [Ref/Fdbk Size] The size of the Reference/Feedback. It will either be 16 bits or 32 bits. It
is set in the device and the adapter automatically uses the correct size.

21 - [Datalink Size] The size of the Datalinks. It will either be 16 bits or 32 bits. It is set in the
device and the adapter automatically uses the correct size.

26 - [DPI 1/0 Act] The Reference/Feedback and Datalinks used by the adapter. This value
is the same as Parameter 25 - [DPI I/0 Cfg] unless the parameter was
changed and the adapter was not reset.

ololo|o|m|<|
Bit 2SS EIEIEIEIR
Definiton |2 |22/ S|s|s S|
2228888 §
Defaut  [x[x[xJ0[0J0[0]1 0=1/0 disabled
Bit 7 6 5 413 2 10 1 =1/0 enabled

50 - [Peer Inp Status] | The status of the consumed peer input connection.

Values

0 = Off

1 = Waiting

2 = Running
3 = Faulted

Updat"]g the Adapter The adapter firmware can be updated over the network or serially through a
Firmware direct connection from a computer to the drive usinga 1203-USB or 1203-SSS

serial converter.

When updating firmware over the network, you can use the Allen-Bradley
ControlFLASH software tool, the built-in update capability of DriveExplorer
Full software, or the built-in update capability of DriveExecutive software.

When updating firmware through a direct serial connection from a computer to a
drive, you can use the same Allen-Bradley software tools described above, or you

can use terminal emulation software set to the X-modem protocol.

If using a direct serial connection, you can use DriveExplorer Lite software.
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To obtain a firmware update for this adapter, go to http://www.ab.com/support/
abdrives/webupdate. This website contains all firmware update files and

associated Release Notes that describe the following items:

* Firmware update enhancements and anomalies
* How to determine the existing firmware revision

* How to update firmware using DriveExplorer, DriveExecutive,
ControlFLASH, or HyperTerminal software
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Configuring the 1/0

This chapter provides instructions on how to configure a Rockwell Automation
ControlLogix or MicroLogix 1100/1400 controller to communicate with the
adapter and connected PowerFlex drive.

Topic Page
Using RSLinx Classic Software 47
ControlLogix Controller Example 48
MicroLogix 1100/1400 Controller Example 68
Using RSL"]x C|assic RSLinx Classic software, in all its variations (Lite, Gateway, OEM, and so forth),

is used to provide a communication link between the computer, network, and

Software

controller. RSLinx Classic software requires its network-specific driver to be
configured before communication is established with network devices. To
configure the RSLinx driver, follow this procedure.

1. Start RSLinx Classic software and select Communications > Configure
Drivers to display the Configure Drivers screen.

2. From the Available Driver Types pull-down menu, choose EtherNet/IP
Diriver.

3. Click Add New... to display the Add New RSLinx Driver screen.

4. Use the default name or type a new name and click OK. The ‘Configure
driver:’ screen appears.

5. Depending on your application, select either the browse local or remote
subnet option.

6. Click OK.
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The Configure Drivers screen reappears with the new driver in the
Configured Driverslist.

7. Click Close to close the Configure Drivers screen.

8. Keep RSLinx running and verify that the computer recognizes the drive.
a. Select Communications > RSWho.
b. Inthemenutreg click ‘+' next to the Ethernet driver.

If the ‘EtherNet/IP driver’ cannot see your drive, as an alternative, use
cither the ‘Ethernet devices’ or ‘Remote Devices via Linx Gateway’ RSLinx

driver.
cOntrolLogix cO ntroller After the adapter is configured, the connected drive and adapter will be a single
EX ampl e node on the network. This section provides the steps needed to configure a simple

EtherNet/IP network (see Figure 8). In our example, we will configure a
ControlLogix controller with 1756-ENBT (Series A) bridge to communicate
with a drive using Logic Command/Status, Reference/Feedback, and 16
Datalinks (8 to read and 8 to write) over the network.

Figure 8 - Example ControlLogix EtherNet/IP Network

IP Address 10.91.100.80
ControlLogix Controller
with 1756-ENBT Bridge

[O\ /O
e IP Address 10.91.100.79
PowerFlex 70 Drive with
U = = 20-COMM-ER Adapter
DEF < o
O

G
Ethernet
Switch

Computer with
Ethernet Connection
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Adding the Bridge to the 1/0 Configuration

To establish communications between the controller and adapter over the
network, you must first add the ControlLogix controller and its bridge to the I/O
configuration. This procedure is similar for all RSLogix 5000 versions.

1. Start RSLogix 5000 software.
2. Select File > New to display the New Controller screen.

New Controller &\

“Yendor, Allen-Bradley

Tope: 1756 L83 CantralLogix5563 Contraller | 3 |
Revizior: 16 A Cancel
[ Redundancy Enabled Help

Mame: |v1 B_Example_using_20COMME

Drescription Erample showing how to control a PowerFlex FOEC
diive with a 20-COMM-E EtherMet/IP adapter using
FSLogix 5000 16 software.

Chassis Type: |1?55-A? 7-5lot ControlLogis Chassis j

Slat: 0 3:
Create In: |C ‘R SLogix S000YProjects Browse...

a. Choose the appropriate choices for the fieldsin the screen to match
your application.

b. Click OK.

The RSL ogix 5000 window reappears with the treeview in the left
pane.

3. In the treeview, right-click the I/O Configuration folder and choose New
Module...

The Select Module screen appears.

4. Expand the Communications group to display all of the available
communication modules.

M Sclect Module ]
Module Description Vendor
1756-DHRIC/C 1756 DH+ Bridge/RIO Scanner Allen-Eradley ~
1756-DHRIO/D 1756 DH+ Bridge/RIO Scanner Allen-Bradley
1756-DNE 1756 DeviceNet Scanner Allen-Eradley
1756-EM2T/A 1756 10/100 Mbps Ethernet Bridge, Twisted-Pair Media Allen-Bradley
1756-EMBT/A 1756 10/100 Mbps Ethernet Bridge, Twisted-Pair Media Allen-Eradley
1756-ENET/A 1756 Ethernet Communication Interface Allen-Bradley
1756-EMET/B 1756 Ethernet Communication Interface Allen-Eradley
1756-EWEB/A 1756 10/100 Mbps Ethernet Bridge w/Enhanced Web Services  Allen-Bradley
1756-5YMCH/A Synchlink Interface Allen-Eradley
i Controllers
- Digital
E- Drives
= Motion b/
KA i
Find... Add Favorite
By Category By Yendor Favarites J

oK Cancel | Help ‘

5. In thelist, select the EtherNet/IP bridge used by your controller.
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In this example, we use a 1756-ENBT EtherNet/IP Bridge (Series A),
so the 1756-ENBT/A option is selected.

6. Click OK.

7. In the Select Major Revision pop-up dialog box, select the major revision
of its firmware.

8. Click OK.
The bridge’s New Module screen appears.

9. Edit the following:

Box Setting

Name A name to identify the EtherNet/IP bridge.

Description | Optional — description of the EtherNet/IP bridge.

IP Address | The IP address of the EtherNet/IP bridge.

Host Name | Not used.

Slot The slot of the EtherNet/IP bridge in the rack.

Revision The minor revision of the firmware in the bridge. (You already set the major
revision by selecting the bridge series in step 5.)

Electronic Compatible Keying. The ‘Compatible Keying’ setting for Electronic Keying
Keying ensures the physical module is consistent with the software configuration
before the controller and bridge make a connection. Therefore, be sure that
you have set the correct revision in this screen. See the online Help for
additional information on this and other Electronic Keying settings. If keying is
not required, select ‘Disable Keying'. Disable keying is recommended.

Open When this box is checked, clicking OK opens additional module properties
Module screens to further configure the bridge. When unchecked, clicking OK closes
Properties the bridge’s New Module screen. For this example, uncheck this box.

10. Click OK.

The bridge is now configured for the EtherNet/| P network, added to the
RSL ogix 5000 project, and appearsin the I/O Configuration folder. In
our example, a1756-ENBT bridge appears under the I/O Configuration
folder with its assigned name.

=1-E5 1/0 Configuration
-8 1756 Backplane, 1756-A7
ﬁl [0] 1756-L63 v16_Example_using_20COMME

=B [ [5] 1756-ENBT/A My _EtherNet_IP_Bridge

£ Ethernet
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For convenience, keep the project open. Later in this chapter the project
will need to be downloaded to the controller.

There are three ways to add the adapter into the I/O configuration:

* Device Add-on Profiles (RSLogix 5000 software, version 16.00 or later)
* Classic Profile (RSLogix 5000 software, versions 13.00...15.00)
* Generic Profile (RSLogix 5000 software, all versions)

These are described in separate sections below. If your version of RSLogix 5000
software supports device Add-on Profiles, we recommend that you use this
method.

Using RSLogix 5000 Device Add-on Profiles, Version 16.00 or Later

When compared to using the RSLogix 5000 Classic Profile (versions
13.00...15.00) or Generic Profile (all versions), the RSLogix 5000 device Add-on
Profiles provide the following advantages:

* Profiles for specific drives that provide descriptive controller tags for basic
control I/O words (Logic Command/Status and Reference/Feedback)
and Datalinks. Additionally, Datalinks automatically take the name of the
drive parameter to which they are assigned. These profiles virtually
eliminate I/O mismatch errors and substantially reduce drive
configuration time.

* New Drive tab eliminates the need for a separate drive software
configuration tool.

* Drive configuration settings are saved as part of the RSLogix 5000
software, version 16.00 or later, project file ((ACD) and also downloaded
to the controller.

* Unicast connection (RSLogix 5000 software, version 18.00 or later)

* Device Add-on Profiles can be updated anytime. When a new drive is used
or to benefit from new updates for Add-on Profiles, you will need the
newest Add-on Profile update. Go to www.ab.com/support/abdrives/
webupdate to download the latest RSLogix 5000 device Add-on Profile.
To determine your device Add-on Profile version, see Allen-Bradley
Knowledgebase document #65882.

Add the Drive/Adapter to the I/0 Configuration
To transmit data between the bridge and the drive, you must add the drive as a

child device to the parent bridge. In this example, RSLogix 5000 software,
version 16.00 is used with device Add-on Profile version 4.05 or later.
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1. In the treeview, right-click on the bridge and choose New Module... to
display the Select Module screen.

In our example, weright-click on the 1756-ENBT/A bridge. Expand the
Drives group to display all of the available drives with their
communication adapters.

TIP If the PowerFlex drive is not shown, go to www.ab.com/support/abdrives/
webupdate and download the latest RSLogix 5000 device Add-on Profile.

2. From the list, select the drive and its connected adapter.
For this example, we selected  PowerFlex 70 EC-E’.
3. Click OK.
The drive’'s New Module screen appears.

4. On the General tab, edit the following data about the drive/adapter.

Box Setting

Name A name to identify the drive.

Description Optional — description of the drive/adapter.
IP Address The IP address of the adapter.

5. On the New Module screen in the Module Definition section, click
Change... to launch the Module Definition screen and begin the drive/
adapter configuration process.

In this example, Datalinks are used to do the following.

Read... Write to...

Output Current (Parameter 3) Accel Time 1 (Parameter 140)

DC Bus Voltage (Parameter 12) Decel Time 1 (Parameter 142)

Fault 1 Code (Parameter 243) High Resolution Reference (Parameter 308)

TIP To get the latest RSLogix 5000 device Add-on Profile, go to
www.ab.com/support/abdrives/webupdate.
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6. In the Module Definition screen, edit the following information.

Box

Setting

Revision

The major and minor revision of the firmware (database) in the drive. If the
drive’s major and minor revision is not available, the drive database is not
installed on your computer. To get the correct database revision, use one of the
following buttons at the bottom left of the Module Definition screen:

- Create Database: Creates a database from an online network drive. Clicking
this button displays an RSLinx software RSWho window. Browse to the
online drive (for this example, PowerFlex 70 EC), select it, and click OK. The
database will be uploaded and stored on the computer. Thereafter, close the
Module Definition screen and then re-open it to display the new revision.

+ Web Update: When a drive is not available online, opens the Allen-Bradley
Drives Web Updates website to download a specific database file. After
downloading the file, close the Module Definition screen and then re-open it
to display the new revision.

* Match Drive: Use this button when the drive being added to the network
matches the drive profile (revision, rating, configuration seftings, and so
forth) of an existing online network drive. Click this button to conveniently
create a duplicate drive profile from the online drive, and automatically load
this identical information into the Module Definition screen. This eliminates
the need to manually enter the information each time a new drive with a
matching profile is added to the network.

Electronic
Keying

Compatible Module. The ‘Compatible Module’ setting for Electronic Keying
ensures that the physical module is consistent with the software configuration
before the controller and bridge make a connection. Therefore, be sure that you
have set the correct revision in this screen. See the online Help for additional
information on this and other Electronic Keying settings. If keying is not
required, select ‘Disable Keying'. Drives do not require keying, and so ‘Disable
Keying' is recommended.

Drive
Rating

The voltage and current rating of the drive. If the drive rating is not listed, the
drive database is not installed on your computer. To get the correct drive rating,
use the Create Database, Web Update, or Match Drive button described
above.

Connection

Parameters via Datalinks. When selecting ‘Parameters via Datalinks’ (default),
the controller tags for the Datalinks use the drive parameter names to which
they are assigned. When selecting ‘Datalinks’, the controller tags for the
Datalinks have non-descriptive UserDefinedData[n] names like those used in
RSLogix 5000 software, version 15.00.

Data
Format

Parameters. When the Connection field is set to ‘Parameters via Datalinks’,
‘Parameters’ is automatically selected. When the Connection field is set to
‘Datalinks’, you must select the number of Datalinks required for your
application in the ‘Data Format’ field.

Datalink
A B C,D

In the Input Data column, assigns selected drive parameters to be READ by the
controller. In the Output Data column, assigns selected drive parameters to be
WRITTEN by the controller.

Sort Input/
Output
selection...

When this box is checked, sorts the Input Data and Output Data assigned
parameters by name and then by number, and enables parameter search by
name. When unchecked, sorts the assigned parameters by parameter number
and then by name, and enables parameter search by number.

Use
Network
Reference

Conveniently selects the speed reference for the drive to come from the
network. This box is checked by default.

When a 32-bit parameter is selected for Input Data or Output Data for a
drive with 16-bit Datalinks, two contiguous Datalinks (for example, x1
and x2, where x = A, B, C or D) are automatically assigned as a pair to
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represent that parameter. See Datalink examples in the screen shown on
the previous page. For more information on Datalinks, see Using

Datalinks on page 86.

On the Module Definition screen, notice that the automatically-assigned
controller tags DriveStatus, OutputFreq, DriveLogicRslt, and
CommandedFreq are always used.

When a Datalink is enabled, the following 20-COMM-ER adapter I/O

parameters are automatically set:

— Parameter 25 - [DPI 1/0O Cfg] turns on the enabled Datalink bit so

the 20-COMM-ER adapter will communicate that Datalink’s
information with the drive.

Parameter 37 - [M-SInput] turnson the enabled Datalink bit so the
20-COMM-ER adapter will input that Datalink’s information from
the controller.

Parameter 38 - [M-S Output] turns on the enabled Datalink bit so
the 20-COMM-ER adapter will output that Datalink’sinformation to
the controller.

7. Click OK on the Module Definition screen to save the drive and adapter

configuration and close the screen.

The drive’'s New Modul e screen reappears.
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8. On the New Module screen, click the Connection tab.
M Module Properties: My_EtherNet_IP_Bridge (PowerFlex 70 EC-E 3.2)
General  Connection | Module Infa | Port Configuration | Diive |
Requested Packet Interval [FP) 200] 2] ms(2n-33839)
[ Inkibit Module
[ Major Fault On Controller |f Cannection Fails \whils in Fun Made
Screen for
RSLogix 5000
software, version
Modue Faul 16.00 or 17.00
Status: Offline oK Cancel Help
Screen for
RSLogix 5000

software, version
18.00 or later

9. In the ‘Requested Packet Interval (RPI)’ box, set the value to 5.0

milliseconds or greater.

This value determines the maximum interval that acontroller should use
to move data to and from the adapter. To conserve bandwidth, use
higher values for communicating with low priority devices.

The ‘Inhibit Module’ box, when checked, inhibits the module from
communicating with the RSLogix 5000 project. When the ‘Major Fault on

... box is checked, a major controller fault will occur when the module’s

connection fails while the controller is in the Run Mode. For this example,
leave the ‘Inhibit Module’ and ‘Major Fault On ... boxes unchecked.

Important: Unicast support has been added to RSLogix 5000 software,
version 18.00 or later. However, to also support unicast, the
controller firmware must be version 18.00 or later. Unicast
is recommended whenever possible. For the benefits of
unicast operation, see Preparing for an Installation on

page 18.
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10. On the New Module screen, click the Port Configuration tab.

IP Address

Subnet Mask

General | Connection | Module Info  Port Configuration 1 Dive |

Gateway Address:

[” Enable BootP

Set «

Status:  Offline

o]

Cancel | | Help ‘

11. In the Port Configuration tab screen, edit the following information.

12.

13.

56

Box

Setting

IP Address

The IP address of the adapter that was already set in the General tab. This
field is not configurable (grayed out).

Subnet Mask

The Subnet Mask configuration setting of the network. This setting must
match the setting of other devices on the network (for example,
255.255.255.0).

Gateway
Address

The Gateway Address configuration setting of the network. This setting must
match the setting of other devices on the network (for example,
10.91.100.1).

Enable BootP

When this box is checked, BOOTP is enabled in the adapter and will ignore
the IP address set in the General tab. When unchecked, the controller uses
the set IP address. This is another method to enable/disable BOOTP in the
adapter. For this example, leave this box unchecked.

Click Set to save the Port Configuration information which sets the

corresponding offline Subnet Cfg x and Gateway Cfg x parameters in the

adapter.

Click OK on the New Module screen.

The new node (‘My_PowerFlex_70_EC Drive' in this example) now
appears under the bridge (‘My_EtherNet_IP_Bridge’ inthisexample) in
the 1/0O Configuration folder. If you double-click the Controller Tags,
you will see that module-defined data types and tags have been
automatically created (Figure 9). Notethat all tag names are defined and
Datalinks include the assigned drive parameter name. After you save
and download the configuration, these tags allow you to access the Input
and Output data of the drive viathe controller’s ladder logic.
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Figure 9 - Controller Tags

Hame & | Value «| Force Mask | Sl | Data Type ]
| = My PowerFlex 70 EC_Drive:| 1. {...1 AB:PowerFlex70E...
+ My_PowerFlex_70_EC_Drive:l DriveStatus . Binary  [INT
| My_PowerFles_70_EC_Drive:l DriveStatus_Feady ] Decimal |BOOL
- ty_PowerFles_70_EC_Diive:l DiiveStatus_dctive 1] Decimal |BOOL
| Mu_PowerFlex_70_EC_Drive:l. DriveStatus_ConmmandDir [1] Decimal | BOOL
- My_PowerFlex_70 EC_Drive:l. DriveStatus_ActualDir a Decimal | BOOL
- My_PaowerFlex_70_EC_Drive:l DriveStatus_Accelerating a Decimal | BOOL
| My_PowerFles_70_EC_Drive:|. DiiveStatus_Decelerating ] Decimal |BOOL
- ty_PowerFlex_s0_EC_Drive:l. DiiveStatus_Alam a Decimal |BOOL
| Mu_PowerFlex_70_EC_Drive:l. DriveStatus_Faulted [1] Decimal | BOOL
- My_PowerFlex_70 EC_Drive:l DriveStatus_AtSpeed 1] Decimal |BOOL
- My_PaowerFlex_70_EC_Drive:l DriveStatus_LocalDO a Decimal | BOOL
| My_PowerFles_70_EC_Drive:l. DriveStatus_LocallD1 ] Decimal |BOOL
| ty_PowerFlex_s0_EC_Drive:l DiiveStatus_Local D2 a Decimal |BOOL
| My_PowerFlex_70_EC_Drive:l. DriveStatus_SpdRellD0 1] Decimal | BOOL
- My_PowerFlex_70 EC_Drive:l DriveStatus_SpdReflDl 1] Decimal |BOOL
- My_PowerFlex_70 EC_Drive:l DriveStatus_SpdReflD2 a Decimal |BOOL
ty_PowerFlex_70_EC_Drive:l DiiveStatus_SpdReflD3 a Decimal | BOOL
+ My_PowerFles_70_EC_Drive:l OutputFreg ] Decimal |INT
+ My_PowerFles_70_EC_Drive:l DutputCurrent 0 Decimal |DINT
|| [+ My PowerFlex 70 EC_Drive:l. DCBusVoltage 0 Decimal |[INT
| [+ My PowerFles 70 EC_Drive:l Fault!Code 0 Decimal |INT
|| =/My_PowerFlex_70_EC_Drive:0 floocd AB:PowerFlex70E.
+ My_PowerFles_70_EC_Drive:0.DrivelogicRisk : . Binary  |INT
| ty_PowerFlex_70_EC_Drive:0.DiiveLogicRsk_Stop 1] Decimal |BOOL
| Mu_PowerFlex_70_EC_Drive:0.DriveLogicRslk_Start [1] Decimal | BOOL
- My_PowerFlex_70 EC_Drive:0.DriveLogicRshk_Jog a Decimal | BOOL
- My_PowerFlex_70_EC_Drive:0. DriveLogicRsk_ClearFault [1] Decimal |BOOL
| My_PowerFles_70_EC_Drive:0. Drivel ogicRsk_Forward ] Decimal |BOOL
- ty_PowerFlex_s0_EC_Drive:0.DiveLogicRsk_Reverse a Decimal |BOOL
| Mu_PowerFlex_70_EC_Drive:0.DriveLogicRskk_LocalContl [1] Decimal | BOOL
- My_PowerFlex_70_EC_Drive:0.DriveLogicRsk_MOPIn: a Decimal | BOOL
- My_PawerFlex_70_EC_Drive:0 Drivel ogicRsk_Accell a Decimal | BOOL
| My_PowerFles_70_EC_Diive:0. DiiveL ogicRish_Accel? ] Decimal |BOOL
- ty_PowerFlex_s0_EC_Drive:0.DiveLogicRsk_Decell a Decimal |BOOL
| My_PowerFlex_70_EC_Drive:0.DriveLogicRsk_Decel2 1] Decimal | BOOL
- My_PowerFlex_70_EC_Drive:0.DriveLogicRskk_SpdRefiD0 1] Decimal |BOOL
My_PaowerFlex_70_EC_Drive:0 Drivel ogicRskt_SpdRefiD1 a Decimal | BOOL

Save the I/0 Configuration to the Controller

After adding the bridge and drive/adapter to the I/O configuration, you must

download the configuration to the controller. You should also save the

configuration to a file on your computer.

1. In the RSLogix 5000 window, select Communications > Download.

The Download dialog box appears.

Download offline project w16_E=ample_uzsing_20COMMER' to the
' E controller.

Connected Controller:

Mame: w16_Example_uging_20COMMER

Type: 1756-LE344 ControlLogix5563 Controller
Fath: Ethernett10.91.100.804B ackplane\0
Serial Mumber: 00244880

Security, Mo Protection

& DAMGER: Unexpected hazardous motion of machinery may ocour,

Some devices maintain independent configuration settings that are
not lnaded to the device during the download of the controller.

Weiify these devices [drives, network devices, 3rd party products)

Failure to load proper configuration could result in misaligned data and
unexpected equipment operation.

Download | Cancel Help

have been properly lnaded before placing the contraller inta mn mode.
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TIP If a message box reports that RSLogix 5000 software is unable to go online,

select Communications > Who Active to find your controller in the Who
Active screen. After finding and selecting the controller, click Set Project
Path to establish the path. If your controller does not appear, you need to add
or configure the EtherNet/IP driver with RSLinx software. See Using RSLinx
Classic Software on page 47 and RSLinx online help for details.

2. Click Download to download the configuration to the controller.

When the download is successfully completed, RSL ogix 5000 software
goes into the Online mode and the 1/0O Not Responding box in the
upper-left of the window should be flashing green. Also, ayellow
warning symbol  should be displayed on the 1/O Configuration folder
in the treeview and on the drive profile.

If the controller was in Run Maode before clicking Download, RSLogix
5000 software prompts you to change the controller mode back to
Remote Run. In this case, choose the appropriate mode for your
application. If the controller was in Program Mode before clicking
Download, this prompt will not appear.

3. Select File > Save.

If thisisthefirst time you saved the project, the Save As dialog box
appears.

a. Navigateto afolder.
b. Typeafile name.
c. Click Save to save the configuration to afile on your computer.

To be sure that the present project configuration values are saved,
RSL ogix 5000 software prompts you to upload them. Click Yesto
upload and save the values.

Correlate the Drive with the Controller

You must now correlate the drive settings to the RSLogix 5000 project I/O
settings so that they match. This requires loading the project I/O settings into the
drive.

1. In the treeview under I/O Configuration, right-click on the drive profile
(for this example, My_PowerFlex_70_EC_Drive) and choose Properties.
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2. Click the Drive tab.

B Module Properties: My_EtherNet_IP_Bridge (PowerFlex 70 EC-E 3.2)

Geneml] Connection] Module Info I Port Corfiguration  Drive 1

(8 B[] 5|  Oivestt Comnected

Comelation with online drive has not been completed. No drive
data can be displayed until comelation has completed successfully
Click the Connect to Drive button to begin comelation

Status  Fauled oK | conce | | hep |

3. Click Connect to Drive to begin the correlation process.

After the drive configuration data has been verified, a pop-up dial og box
appears, which synchronizes ports from the online drive to the project to
be sure that correct Datalinks are assigned.

4. Click OK.

If the Differences Found screen appears—which istypical, click
Download. Thiswill download the project settings from the controller
to the drive and its connected adapter. If Upload is clicked, the drive
and adapter settings are uploaded to the controller.

TIP On subsequent connections to the drive (after initial download), click Upload.

5. When the Reset Comm Module screen appears, click Yes to reset the
communication adapter so that the new I/O settings take effect.

After resetting the communication module, which may take up to a minute
to complete, the I/O OK box in the upper-left of the RSLogix 5000

window should now be steady green and the yellow warning symbols  in
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the treeview under the I/O Configuration folder and drive profile should
be gone.

TIP |f the yellow warning symbol  for your drive remains displayed, first try
power cycling the drive. Otherwise, double-click the drive under the I/0 tree and
click the Connection tab to find the cause of the problem.

6. The Module Properties Drive Tab screen re-appears.

You can view the drive’s Parameter List, Diagnostic Items List, and lists
for any connected peripheral, including the 20-COMM-ER. While
connected to the drive, you can dynamically change values of
parameters. Diagnostic items and diagram views can be used for
troubleshooting. Table 24 on page 147 provides diagnostic items for
troubleshooting the adapter.

7. Click OK when finished to close the Module Properties screen for the
drive.

Using the RSLogix 5000 Classic Profile, Versions 13.00...15.00

When compared to using the RSLogix 5000 Generic Profile (all versions), the
RSLogix 5000 Classic Profile provides these advantages:

* Profiles for specific drives (Figure 10) that provide descriptive controller
tags for basic control I/O words (Logic Command/Status and Reference/
Feedback). The controller tags for Datalinks, however, have non-
descriptive UserDefinedData[n] names.

* Improved I/O configuration—no I/O assembly configuration required.

Basic control I/O is defined, but Datalinks still need to be configured/
mapped.
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* The Setup tab includes a DriveExecutive icon link to conveniently launch
DriveExecutive software (when installed on computer) to match the
adapter I/O configuration with the controller, and to assign the Datalink
parameters in the drive. This reduces I/O mismatches.

TIP  Since the RSLogix 5000 Classic Profile has been significantly improved upon by
RSLogix 5000 Device Add-on Profiles, version 16.00 or later, we recommend using
RSLogix 5000 Device Add-on Profiles to take advantage of its benefits (more
intuitive, time saving, and less likely to make 1/0 configuration errors).

Figure 10 - Classic Profile Screens for Drives

M Select Module @

Module Description
=l Drives ~
150 SMC Flex-E 150 SMC Flex via 20-COMM-E
1305-ACDrive-EN1 1305 AC Drive via 1203-EN1
1336E-IMPACTDrive-EN1 1336 IMPACT Drive via 1203-EN1
1336F-PLUSIIDrive-EM1 1336 PLUS II Drive via 1203-EN1
1336R-REGENBrake-EN1 1335 REGEM Brake via 1203-EN1
1336T-FORCEDriveCHA-EM1 1336 FORCE Drive (ControlMet Adapter) via 1203-EM1
1336T-FORCEDrivePLC-EM1 1336 FORCE Drive (PLC Comm Adapter) via 1203-EN1
1336T-FORCEDriveStd-EN1 1336 FORCE Drive (Standard Adapter) via 1203-EM1
139 7DigitalDCDrive-EM1 1397 Digital DC Drive via 1203-EN1
PowerFlex 70-E PowerFlex 70 Drive via 20-COMM-E
PowerFlex 700 Vector-200V-£ PowerFlex 700 Vector Drive (208/240V) via 20-COMM-E ¥
ﬂ—‘ B Module Properties: My_EtherNet_IP_Bridge (PowerFlex 70 EC-E 3.2)

General 1 Cnnnactmn} Mﬂdulelnfn] inarl Setup I

e Type: PowerFlex 70 EC-E PowerFlex 70 EC Drive via 20-COMM-ER
Wendar: Allen-Bradley
Mame: ‘My,PoweuFleij,EE,Dmve Address / Host Name
Description: * |PAddress: | 10 . 81 100 0 73
" Host Name: ,7
Comm Format: ‘ J

Datalinks: | 4 «| Each datalink has twa
inputs and bwao outputs
Bevizion; ’— 2 J;I Electionic: Keying: | Compatible Keying -

size: [16-bit)

Status: Offline 0K Cancel | | Help |

When Datalinks are used, you must enable the desired Datalinks and assign
names to their non-descriptive controller tags. When a Datalink is enabled, you
must set the following adapter I/O parameters:

* Parameter 25 - [DPII/O Cfg] turns on the enabled Datalink bit so the
20-COMM-ER adapter will communicate that Datalink’s information
with the drive.

* Parameter 37 - [M-S Input] turns on the enabled Datalink bit so the 20-
COMM-ER adapter will input that Datalink’s information from the
controller.

* Parameter 38 - [M-S Output] turns on the enabled Datalink bit so the

20-COMM-ER adapter will output that Datalink’s information to the
controller.
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When using Datalinks, up to 8 [Data In xx] parameters and/or up to 8 [Data Out
xx] parameters must be assigned to point to the appropriate drive parameters for
your application.

Using the RSLogix 5000 Generic Profile, All Versions

We recommend that you use the basic RSLogix 5000 Generic Profile for only the
following reasons:

* A specific drive profile in other versions of RSLogix 5000 software is
unavailable.

* Users are already familiar with a drive Generic Profile and do not want to

convert an existing project to a Classic Profile, versions 13.00...15.00, or to
a device Add-on Profile (RSLogix 5000 software, version 16.00 or later).

* A project must maintain specific revision level control.
* The controller cannot be taken offline. RSlogix 5000 software, version

16.00 or later, enables the drive Generic Profile to be added while the
controller is online and in the Run mode.

Add the Drive/Adapter to the I/0 Configuration

To transmit data between the bridge and the drive, you must add the drive as a
child device to the parent bridge.

1. In the treeview, right-click the bridge and select New Module... to display
the Select Module screen.

M Select Module B3
Module Description
1769-L 35E Ethernet Port 10/100 Mbps Ethernet Port on CompactLogix5335E r
1788-EM2DN/A 1788 Ethernet to DeviceNet Linking Device
1783-ENBT/A 1788 10/100 Mbps Ethernet Bridge, Twisted-Pair Media
1788-EWEB/A 1788 10/100 Mbps Ethernet Bridge w/Enhanced Web Services
1794-AENT /A 1794 10/100 Mbps Ethernet Adapter, Twisted-Pair Media
Drivelogix5730 Ethernet Port 10100 Mbps Ethernet Port on Drivelogix 5730
ETHERNET-BRIDGE Generic EtherNet/IP CIP Bridge
EtherMet/IP SoftLogix5800 EtherMet/IP
PH-PSSCEMASA Ethernet Adapter, Twisted-Pair Media
#- Drives
- HMI
v
K| o]
Find. Add Favorite
By Category By ‘Yendor Favorites J
oK | Cancel Help

In our example, we right-click on the 1756-ENBT/A bridge.

2. Expand the Communications group to display all of the available
communication modules.
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3. Select “ETHERNET-MODULE” from the list to configure the drive and
its connected 20-COMM-ER adapter.

4. Click OK.
The drive’'s New Module screen appears.

New Module

Type:
‘endor:
Parent:

Mame:

ETHERNET-MODULE Generic Ethernet Module
Aller-Bradley
My_EtherNet_IP_Bridge

My_PowerFles_70_EC_Drive

Connection Parameters

Address / Host Hame
(' |P Address: 10

¥ Open Module Properties

Description:

Comm Format: | Data - INT -

Input

Output:

100 . 73

" Host Name:
oK

Configuatior: | U i

Azsembly .
Instance:  Sizer

1 = (s
B = et

r
—

Cancel ‘ Help ‘

5. Edit the following information about the drive and adapter.

Box Setting
Name A name to identify the drive and adapter.
Description Optional - description of the drive/adapter.

Comm Format

Data - INT (This setting formats the data in 16-bit words.)

IP Address

The IP address of the adapter.

Open Module
Properties

When this box is checked, clicking OK opens additional module properties
screens to further configure the drive/adapter. When unchecked, clicking
OK closes the drive’s New Module screen. For this example, check this box.

6. Under Connection Parameters, edit the following information.

Box

Assembly Instance

Size

Input

1
(This value is required.)

The value will vary based on your application
(setting of Parameters 25 - [DPI I/O Cfg] and 38 -
[M-S Output]) and the size (16-bit or 32-bit) of the
Reference/Feedback and Datalinks in the drive.
See Table 2, Table 3, or Table 4 on page 64.

Output

2
(This value is required.)

The value will vary based on your application
(setting of Parameters 25 - [DPI 1/O Cfg] and 37 -
[M-S Input]) and the size (16-bit or 32-bit) of the
Reference/Feedback and Datalinks in the drive.
See Table 2, Table 3, or Table 4 on page 64.

Configuration

6
(This value is required.)

0 (This value is required.)

The following tables define the number of 16-bit words that you need to
enter for the Input Size and Output Size boxes depending on your
configuration.
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Table 2 - Devices with 16-hit Reference/Feedback and 16-bit Datalinks
These products include the following:

+ PowerFlex 70 drives with standard or enhanced control

+ PowerFlex 700 drives with standard control

+ SMC Flex smart motor controllers

+ SMC-50 smart motor controllers

* PowerFlex 700H drives
Logic Ref/Fdbk | Datalinks (16-bit) | User Configured Settings
g:)arpuns\andl (16-bit) ale e lp Size in Words | Par. 23 - Par. 35 - Par. 36 -
Input | Output [DP11/O Cfg] | [M-S Input] | [M-S Output]
v v 4 2 ...0 0001 ...0 0001 ...0 0001
4 (4 v 6 4 ...00011 ...00011 ...00011
v v vV |V 8 6 ..00111 ..00111 ...00111
v 4 vV |v |V 10 8 01111 L0111 L0111
v v vV v |V v ]12 10 L1111 L1 L1111
Table 3 - Devices with 16-bit Reference/Feedback and 32-bit Datalinks
These products include the following:
- PowerFlex 700 drives with vector control + PowerFlex Digital DC drives
+ PowerFlex 700L drives with 700 control + SMC Controllers
Logic Ref/Fdbk | Datalinks (32-bit) | User Configured Settings
g:)artr:lnslandl (16-bit) ale lelp Size in Words | Par. 23 - Par. 35- Par. 36 -
Input | Output [DP11/O Cfg] | [M-S Input] | [M-S Output]
4 (4 4 2 ...0 0001 ...0 0001 ...0 0001
4 (4 v 8 6 ...0 0011 ...00011 ...00011
v v vV |V 12 10 ..00111 ..00111 ..00111
v 4 vV |V |V 16 14 L0111 L0111 L0111
4 4 vV | v | v V]2 18 L1111 L1111 L1
Table 4 - Drives with 32-bit Reference/Feedback and 32-bit Datalinks
These products include the following:
+ PowerFlex 700S drives with Phase | or Phase Il control ~ + PowerFlex 753 drives
+ PowerFlex 700L drives with 700S control * PowerFlex 755 drives
Logic Ref/Fdbk | Datalinks (32-bit) | User Configured Settings
g?ar::jn;and/ (32-bit) ale e lp Size in Words | Par. 23 - Par. 35- Par. 36 -
Input | Output [DP11/O Cfg] | [M-S Input] | [M-S Output]
(4 v 6 4 ...0 0001 ...0 0001 ...0 0001
v v v 10 8 ...00011 ...00011 ...00011
4 v v |V 14 12 ..00111 ..00111 ..00111
4 v vV |v |V 18 16 01111 L0111 L0111
4 v vV v |V v ]2 20 L1111 L1 L1111

TIP For instructions on configuring the I/0 for the adapter using Parameter 25 -
[DPI1/0 Cfg] and its Master-Slave Hierarchy using Parameters 37 - [M-S
Input] and 38 - [M-S Qutput], see
Setting the I/0 Configuration on page 35.
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When using Datalinks, up to 8 [Data In xx] parameters and/or up to 8
[Data Out xx] parameters must be assigned to point to the appropriate
device parameters for your application.

7. After setting the information in the device’s New Module screen, click OK.
The Module Properties screen appears.
8. Click the Connection tab.

B Module Properties: My_EtherNet IP_Bridge (ETHERNET-MODULE 1.1)

General Connection l Maduls Info |

FRequested Packet Interval [RPI): 10, 032 ms  [1.0-3200.0 mg]
™ Inhibit Maodule

™ Major Fault On Contraller IF Connection Fails While in Bun Mode
-
Maodule Fault

Status: Offine 0K | canesl | | e |

\O

. In the ‘Requested Packet Interval (RPI)’ box, set the value to 5.0 ms or
greater.

This value determines the maximum interval that acontroller should use
to move data to and from the adapter. To conserve bandwidth, use
higher values for communicating with low priority devices. For this
example, leave the ‘Inhibit Module' and ‘Major Fault ..." boxes
unchecked.

10. Click OK.

The new node (‘My_PowerFlex_70_EC_Drive' in this example) now
appears under thebridge (' My_EtherNet_IP_Bridge’ inthisexample) in
the I/O Configuration folder. If you double-click the Controller Tags,
you will see that module-defined data types and tags have been
automatically created (Figure 11). After you save and download the
configuration, these tags allow you to access the Input and Output data
of the drive viathe controller’s ladder logic.

For this example, all Datalinks (A, B, C, and D) are enabled. The Input
Size is set to 12 words and the Output Size is set to 10 words. Also, the
following adapter I/O parameters are set to the following values.

Adapter Parameter No. | Setting

25 - [DP11/0 Cfg] XXXX Xxxx xxx1 1111
37 - [M-S Input] XXXX XXxX xxx1 1111
38 - [M-S Output] XXXX XXXX xxx1 1111

11. Reset the adapter (see Resetting the Adapter on page 43) or power cycle

the device.
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For the device speed reference and Datalink parameter values and the
adapter setup parameter values, see Drive and Adapter Parameter

Settings on page 90.

Figure 11 - Controller Tags

MHame I3 | WValue € | Faice Mask (-‘ Siyle | Data Type
|_|# My_PowerFles_70_EC_Drive:C foaal {auul AB:ETHERMET .
— My_PowerFles_70_EC_Drive:| {eonl {anu} AB:ETHERMET_.
1 2 My_PowerFlex_70_EC_Drive:l.Data {...} {-..} Decimal [INT[12]
- + My _PowerFlex_s0_EC_Drive:|.D ata[0] a Decimal | INT
- + My PowerFles_s0_EC_Drive:l.Data[1] a Decimal | INT
- + My PowerFles 70 EC_Drive:l.Data[2] 4] Decimal | INT
- + My PowerFles_70_EC_Drive:|.D ata[3] 1] Decimal | INT
+ My PowerFles_70_EC_Drive:l.Data[4] 1] Decimal | INT
: + My PowerFles_70_EC_Drive:|.D ata[5] a Decimal | INT
- + My _PowerFlex_s0_EC_Drive:|.D ata[B] a Decimal | INT
- + My PowerFles_s0_EC_Drive:l.D ata[7] a Decimal | INT
- + My PowerFles 70 EC_Drive:l.Data[8] 4] Decimal | INT
- + My PowerFles_70_EC_Drive:|.D ata[d] 1] Decimal | INT
+ My PowerFles_70_EC_Drive:|.Data[10] 1] Decimal  |INT
: + My PowerFlex_70_EC_Drive:|.Data[11] a Decimal | INT
= My_PowerFlex_70_EC_Drive:0 {...} {-..} AB:ETHERMET_.
—|-My_PowerFlex_70_EC_Drive:0.Data {...1} {...} Decimal [IMNT[10]
- + My PowerFles_70 EC_Drive:0.Datal0] 4] Decimal | INT
- + My PowerFles_70_EC_Drive:0.Data[1] 1] Decimal | INT
L + My PowerFles_70_EC_Drive:0 Data[2] 1] Decimal  |INT
L + My PowerFles_70_EC_Drive:0.Data[3] a Decimal | INT
- + My PowerFles_70_EC_Drive:0.Data[d] a Decimal | INT
- + My PowerFles_s0_EC_Drive:0.Data[5] a Decimal | INT
- + My PowerFles_70 EC_Drve:0 Data[f] 4] Decimal | INT
- + My PowerFles_70_EC_Drive:0.Data[7] 1] Decimal | INT
L + My PowerFles_70_EC_Drive:0.Data[8] 1] Decimal  |INT
L + My PowerFles_70_EC_Drive:0.Data[3] a Decimal | INT

Save the /0 Configuration to the Controller

After adding the bridge and drive/adapter to the I/O configuration, you must
download the configuration to the controller. You should also save the
configuration to a file on your computer.

TIP When using RSLogix 5000 software, version 16.00 or later, you can add the I/0
configuration of a Generic Profile while the controller is online and in the Run
mode.

1. In the RSLogix 5000 window, select Communications > Download.
The Download dialog box appears.

) Download offiine project *15_Example_using_20COMME' ta the
'\ controler

Connected Contraller:

Mame: <no hame>

Type: 1756-L63/4 ControlLogix5563 Controllsr
Path: Ethernet'10.91.100.80\Backplane'0
Serial Number. 00244888

Security: No Protection

Download Cancel Help
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TIP If a message box reports that RSLogix 5000 software is unable to go online, select
Communications > Who Active to find your controller in the Who Active
screen. After finding and selecting the controller, click Set Project Path to
establish the path. If your controller does not appear, you need to add or configure
the EtherNet/IP driver with RSLinx software. See Using RSLinx Classic
Software on page 47 and RSLinx online help for details.

2. Click Download to download the configuration to the controller.

When the download is successfully completed, RSLogix 5000 software
goes into the Online mode and the I/O OK box in the upper-left of the
screen should be steady green.

3. Select File > Save.

If thisisthe first time you saved the project, the Save As dialog box
appears. Navigate to afolder, type afile name, and click Saveto save
the configuration to afile on your computer.

To be sure that the present project configuration values are saved, RSLogix
5000 software prompts you to upload them. Click Yes to upload and save
the values.

4. Configure any Datalinks in the drive (for example, Datalink parameters
300...317 in PowerFlex 70 drives) that were enabled in the controller and
adapter during I/O configuration (Table 2, Table 3, or Table 4).

Each Datalink being used must be assigned to a specific parameter in the
drive or connected peripheral. If this is not done, the controller will receive
or send placeholder data instead of actual drive or peripheral parameter
values.

5. Place the controller in Remote Run or Run Mode.
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Limitations Using a
MicroLogix 1100/1400
Controller

MicroLogix 1100/1400
Controller Example

68

Controlling I/O with explicit messages is relatively complex compared to
normal implicit 1/O control.

ControlLogix and CompactL ogix controllers with EtherNet/I P provide the
easiest and most integrated form of implicit 1/O control for a device.

RSL ogix 5000 software, version 16.00 or later, for ControlLogix and
CompactL ogix controllers contains integrated profiles for PowerFlex drives
that, with afew clicks of the mouse, automatically create al controller tags
and an implicit connection at the specified Regquested Packet Interval to
control the drive. This connection is monitored at both ends to verify that
the controller and drive are communicating. A watchdog will cause adrive
fault if the drive does not respond within approximately 100 milliseconds.
Therefore, using a ControlLogix or CompactLogix controller is by far the
much preferred method of controlling drives on EtherNet/IP.

If you are not using either of these type of controllers, then devices on
EtherNet/I P can be controlled with explicit messages using MicroL ogix
1100/1400 controllers with the following limitations:

- An explicit message is a much slower form of control and is non-
deterministic. This means that you cannot guarantee how long the device
will take to start up or stop when the command is given. Therefore, all
equipment used in this manner should be subject to arisk assessment,
taking into account the mechanical and electrical implementation.

- A timeout value (in seconds) in the EtherNet/I P adapter will issue a
devicefault if amessage is not received from the controller within the
specified time. However, the controller has no way of detecting aloss of
communication to the device until the next cycle of explicit messages.
Thisis another factor in the risk assessment.

- Any additional devicesto be controlled will require additional explicit
messages for their control, and they need to be carefully sequenced. Most
controllers have small communication queues (see the User Manual),
which need to be carefully managed if messages are not to be lost.

Each controller has alimited number of communication connections (see
its User Manual for maximum connections), which will limit the number
of drives that can be connected.

In summary, unlike a ControlLogix or CompactLogix controller, programming a
MicroLogix 1100/1400 controller by using RSLogix 500 software with explicit
messages is more difficult, and produces a more complex program.

After the adapter is configured, the connected drive and adapter will be a single
node on the network. This section provides the steps needed to configure a
simple EtherNet/IP network (see Figure 12). In our example, we will configure a
MicroLogix 1100 controller to communicate with a drive using Logic
Command/Status, Reference/Feedback, and Datalinks over the network.
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Figure 12 - Example MicroLogix 1100/1400 Controller EtherNet/IP Network

IP Address 10.91.100.81
MicroLogix 1100/1400 Controller

5 @
|:| IP Address 10.91.100.79
Sl PowerFlex 70 Drive with
e | 20-COMM-ER Adapter
a
o]
DD
Ethernet
Switch
Computer with

=~ 1 Ethernet Connection
c————

TIP Information for PowerFlex 750-Series drives has been added where applicable.

Configuring Parameters for Network 1/0

Because the I/O for the drive is message-based, there is no need to configure any
I/O inside the RSLogix 500 project, version 7.00 or later, until using the I/O as

described in Chapter S.

However, to get the adapter to operate with the I/O created in Chapter 5, we
need to configure the adapter to accept the I/O and drive to point to the
appropriate Datalinks.

1. For this example, the following adapter I/O parameters are set to the

following values.
Adapter Parameter No. | Setting
25 - [DPI I/0 Cfg] XXXX XXXX Xxx1 1111
37 - [M-S Input] XXXX XXXX Xxx1 1111
38 - [M-S Output] XXXX XXxX xxx1 1111

2. Reset the adapter (see Resetting the Adapter on page 43) or power cycle

the drive.

For the drive speed reference and Datalink parameter values and the
adapter setup parameter values, refer to Drive and Adapter Parameter
Settings on page 96.
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Creating RSLogix 500 Project, Version 7.00 or Later

To transmit (read and write) data between the controller and drive, you must create
message instructions that allocate data table addresses in the controller for Logic
Command/Status, Reference/Feedback, and Datalinks.

Select the Controller

1. Start RSLogix 500 software.

The RSLogix 500 window appears.
2. Select File > New to display the Select Processor Type screen.
Processor Name: |Ex<4MPLE
= -
Microloois 1500 ISP Series A § o |
Hicrologiz 1200 Series C (1 or 2 Comm Forts) Help

HicroLogiz 1200 Series
Mi T

B
1200 5

Hicrologiz 1000 DH-485-HDSlave
HicroLogiz 1000

24-115 VAC In, 16-RLY Qut
1747-L40B 24-115 VAC In. 16-TRIAC Out
1747-L40C-F 24-DC SHK In. 16-RLY Out
1747-L40E 24-DC SHE In, 16-TRANS SRC Qut

1747-140L 24-DC SRC In. 16-TRANS SHE Out i
Communication settings
Criver Processor Node: Reply Timeout:
Ethemet x| |43 Decimal who Active.. o [Sec.)

(=61 Octal)

3. Assign a name for the processor.

4. In the list, select the MicroLogix 1100.

5. Choose the appropriate choices for the fields in the screen to match your
application.

6. Click OK.
The RSLogix 500 project window appears.
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Create MicroLogix 1100/1400 Ladder Logic for the Control Timeout

1. In the RSLogix 500 project window treeview under Program Files double-
click on LAD 2.

2. Insert aladder rung.
3. Double-click on the rung to display the rung editor.

4. Enter MSG MGxx:n, where:

XX is an unused data file number (for example, MG10:n), and
n is an unused element of the data file chosen for xx (for example, MG10:0)

Press Enter.
Insert another separate rung.
Double-click on the rung to display the rung editor.

Enter BST XIC MGxx:n/DN NXB XIC MGxx:n/ERBND OTU
MGxx:n/EN, where:

xx and n must correspond to the assigned data file number and element
(for example, MG10:0) for the message created in steps 2...5.

e N W

Important: The information must be entered with appropriate numbers
for ‘xx’ and ‘n’ for your application, and with spaces and
forward slashes exactly as shown.

9. Press Enter.

10. In the MSG instruction (Figure 13), double-click Setup Screen to launch
the message configuration screen (Figure 14).

Figure 13 - MicroLogix 1100/1400 Ladder Logic for the Control Timeout

MSG
/m\ Read/Write Message | —{ EN 3——
MSG File  MGI10:0 —DN
Steps 6...9 Semp\Screen —ER +—
MG10:0 \ MG10:0
1 E U™y
1 C LU
DN EN
MG10:0
B
ER

11. Configure the General tab fields by entering or verifying the information
shown in the message configuration screen.
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Figure 14 - MicroLogix 1100/1400 Message Configuration Screens for the Control
Timeout

= MSG - Rung #2:0 - MG10:0

Bl | bukior |
Thiz Controller Control Bits
e Ml Ignore if timed E.H.Il [TO): m
Communication Command: [S00CPL ‘write Br?ak CU”HBC_“E'" [BK) m
Diata Table Addiess: [z0.0 Awaiting Execution [EW): m
Size in Elements: 1
[ Error (ER): [0 ]
Target Device Meszage done [DM): m
Message Timeout : Message Transmitting [ST): m
Deta Table Address: [N42:3 Meszage Enabled [EM). [0
Lacal / Remate : MuliHap:
Routing Information File: Biiig;

= MSG - Rung #2:0 - MG10:0

General MU UD]

Ihs = Add Hop [el = Remave Hop
From Device ‘ From Paort ‘ Tao Address Type | To Address |
This Processor 1 EtherMet IP Device [str] = 10.91.100.73
General Tab Box ‘ Setting
This Controller (data for MicroLogix 1100)
Channel 1 (integral). Controller port to which the network is connected.

Communication Command | 500CPU Write. The controller type and command type for the controller to read or write data.
Because the MicroLogix 1100 is part of the SLC-500 controller family, the ‘500CPU’ controller type
was selected. The ‘Write’ command type was selected to write the control timeout value to the drive.

Data Table Address (! N20:0. An unused controller data table address containing the control timeout value to be written.

Size in Elements @ 1. Number of elements (words) to be transferred. Each element size is a 16-bit integer.

Target Device (data for adapter/drive)

Message Timeout 5. Message timeout duration in seconds.

Data Table Address ©) N42:3. Specific starting address of the destination file in the drive.
Routing Information File RI9:0. An unused routing information file for the controller.
MultiHop Tab Box Setting

To Address 10.91.100.79. The IP address of the adapter connected to the drive.

(1) For details on data table addresses for this example project, see Table 11...Table 14 starting on page 98.

(2) For details to determine element size for a specific drive, see Understanding Controller Data Table Addresses on page 97.

(3) For details on setting the control timeout value and its function, see N-Files on page 192. The Control Timeout (N42:3) is stored in RAM. If the 20-
COMM-ER adapter is power cycled, the Control Timeout Message must be re-sent. If the Control Timeout is not changed from a non-zero value, the
control message (page 75) will error out.

TIP The Control Timeout (N42:3) must be changed to a non-zero value (5...20 seconds
recommended). If the Control Timeout is not changed from a non-zero value, the
control message (page 75) will error out. The Control Timeout is stored in RAM. If
the adapter is power cycled, the Control Timeout Message must be re-sent.
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Create MicroLogix 1100/1400 Ladder Logic for the Logic Status, Feedback,

and Datalink Out

1. Insert another separate rung.

2. Double-click on the rung to display the rung editor.

b

Enter MSG M Gxx:n, where:

xx is an unused data file number (for example, MG11:n), and
n is an unused element of the data file chosen for xx (for example, MG11:0)

Press Enter.

RO

MGxx:n/EN, where:

Insert another scparate rung.

Double-click on the rung to display the rung editor.
Enter BST XIC MGxx:n/DN NXB XIC MGxx:n/ER BND OTU

xx and n must correspond to the assigned data file number and element
(for example, MG11:0) for the message created in steps 1...4.

Important: The information must be entered with appropriate numbers

for ‘xx’ and ‘n’ for your application, and with spaces and

forward slashes exactly as shown.

8. Press Enter.

9. In the MSG instruction (Figure 15), double-click Setup Screen to launch
the message configuration screen (Figure 16).

Figure 15 - MicroLogix 1100/1400 Ladder Logic for the Logic Status, Feedback, and

Datalink Out
M\ -
Read/Write Message [ EN 37—
MSGFile  MGI11:0 (DN >—
Steps 5...8 Semp\Screen —CER —
MGI11:0 \ MG11:0
or U
milln
DN EN
MG11:0
ER

10. Configure the General tab fields by entering or verifying the information
shown in the message configuration screen.
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Figure 16 - MicroLogix 1100/1400 Message Configuration Screens for the Logic
Status, Feedback, and Datalink Out

5 MSG - Rung #2:2 - MG11:0

i| MultiHop ]
This Controller Control Bits
ek Ml lgnare if timed out [TO): E
Communication Command: [S00CPU Read ] B'E_ak EU””ED_"U” (BK:[0]
Data Table Address: [H20:1 Aweaiting Execution [EW]: IE
Size in Elements: |19
Ennor [ERY [1]
Target Device Message done [DMN]. IE
Message Timeout Message Transmitting (5T (0]
Data Table Address: [N41:0 Message Enabled [EN] [0 ]
Local / Remate : MuliHop:
Routing Information File: [R13:1 Error

= M5G - Rung #2:2 - MG11:0

General | Mu\llHupl

Inz =Add Hop Del = Remove Hop
From Device | From Port | To Addiess Type | To Address ‘
This Processor 1 EtherMet IP Device (str]  10.91.100.79
General Tab Box ‘ Setting
This Controller (data for MicroLogix 1100)
Channel 1 (integral). Controller port to which the network is connected.

Communication Command | 500CPU Read. The controller type and command type for the controller to read or write data.
Because the MicroLogix 1100 is part of the SLC-500 controller family, the ‘500CPU’ controller
type was selected. The ‘Read’ command type was selected to read data from the drive.

Data Table Address (*) N20:1. An unused controller data table address containing the data to be read from the drive.

Size in Elements @ 19. Number of elements (words) to be transferred. Each element size is a 16-bit integer.

Target Device (data for adapter/drive)

Message Timeout 5. Message timeout duration in seconds.

Data Table Address ©©) N41:0. Specific starting address of the source file in the drive.
Routing Information File RI9:1. An unused routing information file for the controller.
MultiHop Tab Box Setting

To Address 10.91.100.79. The IP address of the adapter connected to the drive.

(1) For details on data table addresses for this example project, see Table 11...Table 14 starting on page 98.

(2) For details to determine element size for a specific drive, see Understanding Controller Data Table Addresses on page 97.

(3) For N-File details, see N-Files on page 192.
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Create MicroLogix 1100/1400 Ladder Logic for the Logic Command,

Reference, and Datalink In

1. Insert another separate rung.
2. Double-click on the rung to display the rung editor.

Enter MSG MGxx:n, where:
XX is an unused data file number (for example, MG12:n), and

b

n is an unused element of the data file chosen for xx (for example, MG12:0)

Press Enter.
Insert another separate rung.

Double-click on the rung to display the rung editor.

RO

MGxx:n/EN, where:

Enter BST XIC MGxx:n/DN NXB XIC MGxx:n/ERBND OTU

xx and n must correspond to the assigned data file number and element

(for example, MG12:0) for the message created in steps 1...4.

Important: The information must be entered with appropriate numbers

for ‘xx’ and ‘n’ for your application, and with spaces and

forward slashes exactly as shown.

8. Press Enter.

9. In the MSG instruction (Figure 17), double-click Setup Screen to launch

the message configuration screen (Figure 18).

Figure 17 - MicroLogix 1100/1400 Ladder Logic for the Logic Command, Reference,

and Datalink In

Read/Write Message

MG12:0

ER

e

MSGFile MGI2:0 DN —
¢ Scrn ER

Steps 5...8 Semp\Sc:lecn I ER —
MG12:0 \ MG12:0
1 oL

allw

DN \ N

10. Configure the General tab fields by entering or verifying the information

shown in the message configuration screen.
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Figure 18 - MicroLogix 1100/1400 Message Configuration Screens for the Logic
Command, Reference, and Datalink In

=t MSG - Rung #2:4 - MG12:0

 General { MuliHop |
Control Bits
lgnore if timed out (TO): m
Break Connection [BK): m
Awaiting Execution [E%W]: m

This Controller

Chanrel: 1 [|ntegral

Communication Command: (S00CPL white ]

Data Table Address: [N20:20
Size in Elements: [19

Target Device
Message Timeout :
Data Table Address: [N41:0

Local / Remote : MuliHop:
Fiouting Infarmation File: [RI5:2 Errar

=t MSG - Rung #2:4 - MG12:0

Errar [ER]: IE'

Meszage done [DM]: m
Message Transmitting (ST m
Message Enabled [EM]: m

General i UDI

Ihs = Add Hop Del = Remove Hop
Fram Device Fram Part To Address Type | To Address ‘
This Pracessor 1 EtherMet IP Device [str]  10.97.100.79
General Tab Box ‘ Setting

This Controller (data for MicroLogix 1100)

Channel

1 (integral). Controller port to which the network is connected.

Communication Command

500CPU Write. The controller type and command type for the controller to read or write data.
Because the MicroLogix 1100 is part of the SLC-500 controller family, the ‘500CPU’ controller
type was selected. The ‘Write’ command type was selected to write data to the drive.

Data Table Address ()

N20:20. An unused controller data table address containing the data to be written to the drive.

Size in Elements @

19. Number of elements (words) to be transferred. Each element size is a 16-bit integer.

Target Device (data for adapter/drive)

Message Timeout 5. Message timeout duration in seconds.

Data Table Address ) N41:0. Specific starting address of the destination file in the drive.
Routing Information File RI9:2. An unused routing information file for the controller.
MultiHop Tab Box Setting

To Address 10.91.100.79. The IP address of the adapter connected to the drive.

(1) For details on data table addresses for this example project, see Table 11...Table 14 starting on page 98.

(2) For details to determine element size for a specific drive, see Understanding Controller Data Table Addresses on page 97.

(3) For N-File details, see N-Files on page 192.

TIP This message will error out if the Control Timeout value is not changed from a non-
zero value. Refer to page 71 for writing a value to the Control Timeout.

TIP

If the controller is controlling more than one drive, it is recommended to

intersperse the control 1/0 messaging for each drive to conserve network
bandwidth and decrease response time. That is, sequence the message
instructions for each drive so that its group of messages will occur at a different
time than those for another drive.
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Notes:
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Chapter 5

Using the I/0

This chapter provides information and examples that explain how to control,
configure, and monitor a PowerFlex 7-Class drive or SMC using the configured

I/0.
Topic Page
About I/O Messaging 79
Understanding the I/0 Image 80
Using Logic Command/Status 84
Using Reference/Feedback 84
Using Datalinks 86
Example Ladder Logic Program Information 87
ControlLogix Controller Example 88

this publication are intended solely for purposes of example. There are
many variables and requirements with any application. Rockwell
Automation, Inc. does not assume responsibility or liability (to include
intellectual property liability) for actual use of the examples shown in this
publication.

c ATTENTION: Risk of injury or equipment damage exists. The examples in

About I /0 Messag | ng On CIP-based networks, including EtherNet/IP, I/O connections are used to
transfer the data which controls the PowerFlex drive or SMC and sets its
Reference. I/O can also be used to transfer data to and from Datalinks.

The adapter provides many options for configuring and using I/O, including the
following:

* Conlfiguring the size of I/O by enabling or disabling the Logic Command/
Reference and Datalinks.

¢ Settinga Master-Slave or Peer-to-Peer hierarchy.

Chapter 3, Configuring the Adapter, and Chapter 4, Configuring the I/O,
discuss how to configure the adapter and controller on the network for these
options. The defines the different options. This chapter discusses how to use I/O
after you have configured the adapter and controller.
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Understanding the 1/0
Image

80

The terms ‘input’ and ‘output’ are defined from the controller’s point of view.
Therefore, output I/O is data that is produced by the controller and consumed by
the adapter. Input I/O is status data that is produced by the adapter and
consumed as input by the controller. The I/O image will vary based on the
following:

* Size (either 16-bit or 32-bit) of the Reference/Feedback words and
Datalink words used by the device. To determine the size of the Reference/
Feedback and Datalinks, view adapter Parameters 20 - [Ref/Fdbk Size]
and 21- [Datalink Size]. For information to access parameters, see Using

the PowerFlex 7-Class HIM on page 28.

* Configuration of I/O (Parameter 25 - [DPI1/O Cfg]). If all I/O is not
enabled, the image is truncated. The image always uses consecutive words
starting at word 0.

* ControlLogix/CompactLogix Controllers only—The drive profile used
in RSLogix 5000 software (device Add-on Profile in version 16.00 or later,
Classic Profile in versions 13.00...15.00, or Generic Profile in all versions).

ControlLogix Controller Image

Since the device Add-on Profile in RSLogix 5000 software, version 16.00 or later,
and the Classic Profile, versions 13.00...15.00, provide descriptive controller tags,
the I/O image (tag size and location) is automatically configured based on the
device being used. When using the Generic Profile (page 62) in RSLogix 5000

software, however, controller tags are not descriptive or defined.

The ControlLogix controller I/O image changes depending on the size of the
device’s Reference/Feedback and Datalinks. Table , Table , and Table show the I/

O image when using various PowerFlex 7-Class drives, and all Datalinks enabled.
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Table 5 - ControlLogix Controller /0 Image for Devices with 16-bit Reference/
Feedback and 16-bit Datalinks — Using Generic Profile

These products include the following:

+ PowerFlex 70 drives with standard or enhanced control ~ + SMC Flex smart motor controllers
* PowerFlex 700 drives with standard control + SMC-50 smart motor controllers
- PowerFlex 700H drives
Word | Output I/O Word | Input I/0
0 Logic Command 0 Pad Word
1 Reference 1 Pad Word
2 Datalink In A1 2 Logic Status
3 Datalink In A2 3 Feedback
4 Datalink In B1 4 Datalink Out A1
5 Datalink In B2 5 Datalink Out A2
6 Datalink In C1 6 Datalink Out B1
7 Datalink In C2 7 Datalink Out B2
8 Datalink In D1 8 Datalink Out C1
9 Datalink In D2 9 Datalink Out C2
10 Datalink Out D1
11 Datalink Out D2

Table 6 - ControlLogix Controller /0 Image for Devices with 16-bit Reference/
Feedback and 32-bit Datalinks — Using Generic Profile

These products include the following:

+ PowerFlex 700 drives with vector control

+ PowerFlex 700L drives with 700 control

+ PowerFlex Digital DC drives
+ SMC-50 smart motor controllers

18 Datalink Out D2 (LSW)

Word | Output I/O Word | Input I/0

0 Logic Command 0 Pad Word

1 Reference 1 Pad Word

2 Datalink In A1 (LSW) 2 Logic Status

3 Datalink In A1 (MSW) 3 Feedback

4 Datalink In A2 (LSW) 4 Datalink Out A1 (LSW)
5 Datalink In A2 (MSW) 5 Datalink Out A1 (MSW)
6 Datalink In B1 (LSW) 6 Datalink Out A2 (LSW)
7 Datalink In B1 (MSW) 7 Datalink Out A2 (MSW)
8 Datalink In B2 (LSW) 8 Datalink Out B1 (LSW)
9 Datalink In B2 (MSW) 9 Datalink Out B1 (MSW)
10 Datalink In C1 (LSW) 10 Datalink Out B2 (LSW)
11 Datalink In C1 (MSW) 11 Datalink Out B2 (MSW)
12 Datalink In C2 (LSW) 12 Datalink Out C1 (LSW)
13 Datalink In C2 (MSW) 13 Datalink Out C1 (MSW)
14 Datalink In D1 (LSW) 14 Datalink Out C2 (LSW)
15 Datalink In D1 (MSW) 15 Datalink Out C2 (MSW)
16 Datalink In D2 (LSW) 16 Datalink Out D1 (LSW)
17 Datalink In D2 (MSW) 17 Datalink Out D1 (MSW)

(
(

19 Datalink Out D2 (MSW)
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Table 7 - ControlLogix Controller I/0 Image for Drives with 32-bit Reference/
Feedback and 32-bit Datalinks — Using Generic Profile
These products include the following:
* PowerFlex 700S drives with Phase | or Phase Il control
* PowerFlex 700L drives with 700S control

+ PowerFlex 753 drives
+ PowerFlex 755 drives

Word | Output I/O Word | Input I/O

0 Logic Command 0 Pad Word

1 Not Used 1 Pad Word

2 Reference (LSW) 2 Logic Status

3 Reference (MSW) 3 Not Used

4 Datalink In A1 (LSW) 4 Feedback (LSW)

5 Datalink In A1 (MSW) 5 Feedback (MSW)

6 Datalink In A2 (LSW) 6 Datalink Out A1 (LSW)

7 Datalink In A2 (MSW) 7 Datalink Out A1 (MSW)

8 Datalink In B1 (LSW) 8 Datalink Out A2 (LSW)

9 Datalink In B1 (MSW) 9 Datalink Out A2 (MSW)

10 Datalink In B2 (LSW) 10 Datalink Out B1 (LSW)

11 Datalink In B2 (MSW) 11 Datalink Out B1 (MSW)

12 Datalink In C1 (LSW) 12 Datalink Out B2 (LSW)

13 Datalink In C1 (MSW) 13 Datalink Out B2 (MSW)

14 Datalink In C2 (LSW) 14 Datalink Out C1 (LSW)

15 Datalink In C2 (MSW) 15 Datalink Out C1 (MSW)

16 Datalink In D1 (LSW) 16 Datalink Out C2 (LSW)

17 Datalink In D1 (MSW) 17 Datalink Out C2 (MSW)

18 Datalink In D2 (LSW) 18 Datalink Out D1 (LSW)

19 Datalink In D2 (MSW) 19 Datalink Out D1 (MSW)
20 Datalink Out D2 (LSW)
21 Datalink Out D2 (MSW)

MicroLogix 1100/1400 Controller Image

The I/0 image for these controllers always has 19 words of output and 19 words
of input. However, depending on the size of the device’s Reference/Feedback and
Datalinks, specific words in the I/O image may not be used. Table 8, Table 9, and
Table 10 show the I/O image when using various PowerFlex 7-Class drives, and

all Datalinks enabled.
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Table 8 - MicroLogix 1100/1400 I/0 Image for PowerFlex 70/ 700/700H Drives and
SMC Flex (16-bit Reference/Feedback and 16-bit Datalinks)

Word | Output I/O Word | Input /O

0 Logic Command 0 Logic Status

1 Not used 1 Not used

2 Reference (MSW) 2 Feedback (MSW)

3 Not used 3 Not used

4 Datalink In A1 (MSW) 4 Datalink Out A1 (MSW)
5 Not used 5 Not used

6 Datalink In A2 (MSW) 6 Datalink Out A2 (MSW)
7 Not used 7 Not used

8 Datalink In B1 (MSW) 8 Datalink Out B1 (MSW)
9 Not used 9 Not used

10 Datalink In B2 (MSW) 10 Datalink Out B2 (MSW)
11 Not used 11 Not used

12 Datalink In C1 (MSW) 12 Datalink Out C1 (MSW)
13 Not used 13 Not used

14 Datalink In C2 (MSW) 14 Datalink Out C2 (MSW)
15 Not used 15 Not used

16 Datalink In D1 (MSW) 16 Datalink Out D1 (MSW)
17 Not used 17 Not used

18 Datalink In D2 (MSW) 18 Datalink Out D2 (MSW)

Table 9 - MicroLogix 1100/1400 I/0 Image for PowerFlex 700 VC Drives and SMC-50
Controllers (16-bit Reference/Feedback and 32-bit Datalinks)

Word | Output I/O Word | Input /O

0 Logic Command 0 Logic Status

1 Not used 1 Not used

2 Reference (MSW) 2 Feedback (MSW)

3 Datalink In A1 (LSW) 3 Datalink Out A1 (LSW)
4 Datalink In A1 (MSW) 4 Datalink Out A1 (MSW)
5 Datalink In A2 (LSW) 5 Datalink Out A2 (LSW)
6 Datalink In A2 (MSW) 6 Datalink Out A2 (MSW)
7 Datalink In B1 (LSW) 7 Datalink Out B1 (LSW)
8 Datalink In B1 (MSW) 8 Datalink Out B1 (MSW)
9 Datalink In B2 (LSW) 9 Datalink Out B2 (LSW)
10 Datalink In B2 (MSW) 10 Datalink Out B2 (MSW)
11 Datalink In C1 (LSW) 11 Datalink Out C1 (LSW)
12 Datalink In C1 (MSW) 12 Datalink Out C1 (MSW)
13 Datalink In C2 (LSW) 13 Datalink Out C2 (LSW)
14 Datalink In C2 (MSW) 14 Datalink Out C2 (MSW)
15 Datalink In D1 (LSW) 15 Datalink Out D1 (LSW)
16 Datalink In D1 (MSW) 16 Datalink Out D1 (MSW)
17 Datalink In D2 (LSW) 17 Datalink Out D2 (LSW)
18 Datalink In D2 (MSW) 18 Datalink Out D2 (MSW)
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Using Logic Command/
Status

Using Reference/Feedback

Table 10 - MicroLogix 1100/1400 I/0 Image for PowerFlex 700S Series Drives (32-bit
Reference/Feedback and 32-bit Datalinks)

Word | Output I/O Word | Input /O

0 Logic Command 0 Logic Status

1 Reference (LSW) 1 Feedback (LSW)

2 Reference (MSW) 2 Feedback (MSW)

3 Datalink In A1 (LSW) 3 Datalink Out A1 (LSW)
4 Datalink In A1 (MSW) 4 Datalink Out A1 (MSW)
5 Datalink In A2 (LSW) 5 Datalink Out A2 (LSW)
6 Datalink In A2 (MSW) 6 Datalink Out A2 (MSW)
7 Datalink In B1 (LSW) 7 Datalink Out B1 (LSW)
8 Datalink In B1 (MSW) 8 Datalink Out B1 (MSW)
9 Datalink In B2 (LSW) 9 Datalink Out B2 (LSW)
10 Datalink In B2 (MSW) 10 Datalink Out B2 (MSW)
11 Datalink In C1 (LSW) 11 Datalink Out C1 (LSW)
12 Datalink In C1 (MSW) 12 Datalink Out C1 (MSW)
13 Datalink In C2 (LSW) 13 Datalink Out C2 (LSW)
14 Datalink In C2 (MSW) 14 Datalink Out C2 (MSW)
15 Datalink In D1 (LSW) 15 Datalink Out D1 (LSW)
16 Datalink In D1 (MSW) 16 Datalink Out D1 (MSW)
17 Datalink In D2 (LSW) 17 Datalink Out D2 (LSW)
18 Datalink In D2 (MSW) 18 Datalink Out D2 (MSW)

The Logic Command is a 16-bit word of control data produced by the scanner
and consumed by the adapter. The Logic Status is a 16-bit word of status data
produced by the adapter and consumed by the scanner.

This manual contains the bit definitions for most compatible products available

at the time of publication in Appendix D, Logic Command/Status Words. For

other products, see their documentation.

The Reference is produced by the controller and consumed by the adapter. The
Feedback is produced by the adapter and consumed by the controller. The size of
the Reference/Feedback is determined by the drive and displayed using adapter
Parameter 20 - [Ref/Fdbk Size].

Size Valid Values
16-bit | -32768 to 32767
32-bit -2147483648 to 2147483647

When the Reference and Feedback are enabled and a ControlLogix controller
with a device Add-on Profile or Classic Profile is used, specific controller tags are
automatically created, sized (16-bit or 32-bit), and placed in the I/O image.
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PowerFlex 7-Class Drives

The Reference value is an unscaled value; it is NOT in Hertz or RPM. The
Reference uses a 32767 scale. The 32767 endpoint of the scale is equal to the
value of drive parameter 55 - [Maximum Freq], which has a default value of 130
Hz. For all PowerFlex 70/700 drives, default scalingis 0...15123 which is equal to
0...60.0 Hz. This is based on the formula shown below. Reference scaling is
limited by drive parameter 82 - [Maximum Speed]. If the default value of 60 Hz.
for parameter 82 - [Maximum Speed] is changed, the speed Reference scaling also
changes. To determine Reference scaling, use the following formula:

(Parameter 82 + Parameter 55) * 32767 = Scaling
Using drive parameter 82 and 55 default values, speed Reference scaling is:
(60 Hz + 130 Hz) * 32767 = 15123
Therefore, 0...15123 = 0...60.0 Hz.
If parameter 82 - [Maximum Speed] is changed to 90 Hz, then:
(90 Hz = 130 Hz) * 32767 = 22685
Therefore, 0...22685 = 0...90.0 Hz.

A graphic representation of this Reference scaling is shown below.

T 130Hz

T 90hH ced)

g irum SP

g2 60Hz par. 82 - i

>

g OHz

z 0 15123 22685 32767
[Te)

E Scaling = (Parameter 82 + Parameter 55) * 32767

For PowerFlex 70 EC drives, firmware 2.xxx or later, or PowerFlex 700 VC drives,
firmware 3.xxx or later, drive parameter 298 - [DPI Ref Select] was added to
simplify scaling for the speed Reference. When drive parameter 298 - [DPI Ref
Select] is set to its default ‘0’ (Max Freq), the speed Reference scaling is as shown
above. However, when parameter 298 - [DPI Ref Select] is set to ‘1’ (Max Speed),
the speed Reference scaling is equal to parameter 82 - [Max Speed]:

Parameter 82 = Scaling
Using the parameter 82 default value, speed Reference scaling is:
0...32767 =0...60.0 Hz.
If parameter 82 - [Maximum Speed] is changed to 90 Hz, then:
90 Hz = 32767

Speed Feedback uses the same scaling as the speed Reference.
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86

TIP

For PowerFlex 700 VC drives, firmware 3.xxx or later, parameter 299 - [DPI Fdbk Select]
enables you to select the feedback data coming from the drive over DPI. The default is
‘Speed Fdbk’ in Hz or RPM determined by parameter 079 - [Speed Units]. The data
selection for parameter 299 is also displayed on the 1st line of the HIM and on
DriveExplorer and DriveExecutive software screens in the drive status area of the screen.

The controller in the system sends a reference to the SMC, but it is not used for
control purposes in the current release.

The SMC products use the feedback to send motor current information.

A Datalink is a mechanism used by PowerFlex drives and SMCs to transfer data
to and from the controller. Datalinks allow a device parameter value to be read or
written without using an Explicit Message. When enabled, each Datalink
occupies two 16-bit or 32-bit words in both the input and output image. Use
adapter Parameter 21 - [Datalink Size] to determine whether the drive uses 16-
bit or 32-bit words for Datalinks.

Rules for Using Datalinks

* Each set of Datalink parameters in a device can be used by only one
adapter. If more than one adapter is connected to a single device, multiple
adapters cannot use the same Datalink.

* DParameter settings in the device determine the data passed through the
Datalink mechanism. See the documentation for your device.

*  When you use a Datalink to change a value, the value is NOT written to
the Nonvolatile Storage (NVS). The value is stored in volatile memory and
lost when the device loses power. Therefore, use Datalinks when you need
to change a value of a parameter frequently.

Using 16-Bit Datalinks to Read/Write 32-Bit Parameters

This subsection only pertains to the SMC Flex and PowerFlex 70 (SC or EC),
PowerFlex 700 (SC), and PowerFlex 700H drives which use 16-bit Datalinks. To
read or write a 32-bit parameter using 16-bit Datalinks, typically both Datalinks
of a pair (A, B, C, D) are set to the same 32-bit parameter. For example, to read
parameter 10 - [Elapsed Run Time] in a PowerFlex 70 drive, both Datalink Al
Out (Parameter 310) and Datalink A2 Out (Parameter 311) are set to ‘10
Datalink A1 Out will contain the least significant word (LSW) and Datalink A2
Out will contain the most significant word (MSW).
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Example Ladder Logic
Program Information

32-bit data is stored in binary as follows:

MSW | 2% through 2'6
LSW 2" through 20

In this example, the parameter 10 - [Elapsed Run Time] value of 6553.9 Hrs is
read as ‘6553.9” in Datalink A1 Out (Parameter 310) and Datalink A2 Out
(Parameter 311).

Datalink | Word | Parameter | Data (Hex)
A1 Out LSwW 10 0003
A2 Out MSW | 10 0001

Conversion Example:

Parameter 010 - [Elapsed Run Time] = 6553.9 Hrs
MSW = 0001}, = 0001 yjpary = 2'® = 65536
LSW = 0003}, =3

Engineering Value = 65536 + 3 = 65539
Parameter 10 Displayed Value = 6553.9 Hrs

Regardless of the Datalink combination, Datalink x1 Out will always contain the
LSW and Datalink x2 Out will always contain the MSW. In the following
example, the PowerFlex 70 drive parameter 242 - [Power Up Marker] contains a

value of 88.4541 hours.

Datalink | Word | Parameter | Data (Hex)
A2 Out MSW | 242 000D
B1 Out LSW | 242 7F3D

Conversion Example:

Parameter 242 - [Power Up Marker] = 88.4541 hours
MSW = 000Dpey = 1101y = 2% + 2'8 + 210 = 851968
LSW =7F3Dy, = 32573

Engineering Value = 851968 + 32573 = 884541
Parameter 242 Displayed Value = 88.4541 Hrs

The example ladder logic programs in the sections of this chapter are intended for
and operate PowerFlex 7-Class drives and SMC Flex controllers.

Functions of the Example Programs

The example programs enable you to do the following:
* Receive Logic Status information from the drive.
* Send a Logic Command to control the drive (for example, start, stop).
¢ Send a Reference to the drive and receive Feedback from the drive.

¢ Send/receive Datalink data to/from the drive.
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Logic Command/Status Words

These examples use the Logic Command word and Logic Status word for
PowerFlex 70/700 drives. See Appendix D to view details. The definition of the
bits in these words may vary if you are using a different DPI device. See the
documentation for your device.

Creating Ladder Logic Using the RSLogix 5000 Device Add-on
Profiles, Version 16.00 or Later

Because the device Add-on Profile automatically created descriptive controller tags
(Eigure 9) for the entire I/O image in Chapter 4, you can use these tags to directly
control and monitor the device without creating any ladder logic program.
However, if you intend to use Human Machine Interface devices (PanelView, and
so forth) to operate the device and view its status, you will need to create descriptive
user-defined Program tags (Figure 19) and a ladder logic program that will pass the

Controller tag data to the Program tags.

Figure 19 - ControlLogix Program Tags for Device Add-on Profile Ladder Logic
Program Example

M ame & | Style | Data Type |

| Command_Clear_Faults | Decimal EOOL
| Command Fonward Reverse Decimal BOOL
| Command Jog Decimal BOOL
|| Command_Start Decimal BOOL
|| Command_Stop Decimal BOOL
||+ Speed_Fesdback Decimal DINT
| +/Speed Reference Decimal DINT
| Status Active Decimal BOOL
|| Status At Speed Decimal BOOL
|| Status Faulted Decimal BOOL
| Status Fonward Decimal BOOL
| Status Ready Decimal EOOL
|| Status Reverse Decimal BOOL

An example ladder logic program that uses the automatically created descriptive
Controller tags and passes their data to the user-defined Program tags is shown in
Figure 20 and Figure 21. Note that the prefix for the device Controller tags is
determined by the name assigned when configuring the I/O (Chapter 4).
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Figure 20 - ControlLogix Example Ladder Logic Program Using a Device Add-on
Profile for Logic Status/Feedback

My_PowerFlex_Drive:l.DriveStatus_Ready Status_Ready
1E
My_PowerFlex_Drive:l.DriveStatus_Active Status_Active
1 E
My_PowerFlex_Drive:l.DriveStatus_ActualDir Status_Forward
1 E
My_PowerFlex_Drive:l.DriveStatus_ActualDir Status_Reverse
1E
My_PowerFlex_Drive:l. DriveStatus_Faulted Status_Faulted
JE
My_PowerFlex_Drive:l.DriveStatus_AtSpeed Status_At_Speed
JE
MO\
Move —
Source My _PowerFlex_Drive:l.OutputFreq
O«
Dest Speed_Feedback
0«

Figure 21 - ControlLogix Example Ladder Logic Program Using a Device Add-on
Profile for Logic Command/Reference

Command_Stop

My_PowerFlex_Drive O Drivel ogicRslt_Stop

1 E
JC

Command_Start

My_PowerFlex_Drive:O DriveLogicRslt_Start

1 E
JC

Command_Jog

My_PowerFlex_Drive:O.DriveLogicRslt_Jog

J1 E
1 C

Command_Clear_Faults

My_PowerFlex_Drive:O.DriveLogicRsH_ClearFault

JE
3 C

Command_Forward_Reverse

My_PowerFlex_Drive O Drivel ogicRslt_Forward

1 E
J

Command_Forward_Reverse

My_PowerFlex_Drive:O DriveLogicRslt_Reverse

A/ E
a0

MOV-
Move —
Source Speed_Reference
O«
Dest My_PowerFlex_Drive:0.CommandedFreg
O«

Creating Ladder Logic Using the RSLogix 5000 Classic Profile,

Versions 1300...15.00

Since the RSLogix 5000 Classic Profile has been significantly improved upon by

RSLogix 5000 device Add-on Profiles, version 16.00 or later, we highly
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recommended using the RSLogix 5000 device Add-on Profiles to take advantage
of their benefits (more intuitive, time saving, and less likely to make ladder logic
program errors).

Creating Ladder Logic Using the RSLogix 5000 Generic Profile, All
Versions

Drive and Adapter Parameter Settings

The following drive and adapter settings were used for the example ladder logic
program in this section.

Device Parameter Value Description
PowerFlex 70 EC | 90 - [Speed Ref A Sel] | 22 (DPI Port 5) Assigns 20-COMM-ER to be used for the Reference.
Drive 300 - [Data In A1] 140 Points o Par. 140 - [Accel Time 1]
301 - [Data In A2] 142 Points to Par. 142 - [Decel Time 1]
302 - [Data In B1] 100 Points to Par. 100 - [Jog Speed]
303 - [Data In B2] 155 Points to Par. 155 - [Stop Mode A]
304 - [Data In C1] 101 Points to Par. 101 - [Preset Speed 1]
305 - [Data In C2] 102 Points to Par. 102 - [Preset Speed 2]
306 - [Data In D1] 103 Points to Par. 103 - [Preset Speed 3]
307 - [Data In D2] 104 Points to Par. 104 - [Preset Speed 4]
310 - [Data Out A1] 140 Points to Par. 140 - [Accel Time 1]
311 - [Data Out A2] 142 Points to Par. 142 - [Decel Time 1]
312 - [Data Out B1] 100 Points to Par. 100 - [Jog Speed]
313 - [Data Out B2] 155 Points to Par. 155 - [Stop Mode A]
314 - [Data Out C1] 101 Points to Par. 101 - [Preset Speed 1]
315 - [Data Out C2] 102 Points to Par. 102 - [Preset Speed 2]
316 - [Data Out D1] 103 Points to Par. 103 - [Preset Speed 3]
317 - [Data Out D2] 104 Points to Par. 104 - [Preset Speed 4]
20-COMM-ER 04 - [IP Addr Cfg 1] 10.91.100.79 IP address for the adapter.
Adapter :
07 - [IP Addr Cfg 4]
08 - [Subnet Cfg 1] 255.255.248.0 Subnet mask for the adapter.
11 - [Subnet Cfg 4]
23 - [DPI 1/0O Cfg] xxx1 1111 Enables Cmd/Ref and Datalinks A...D.
35 - [M-S Input] xxx1 1111 Configures the I/0 Data to be transferred from the controller on
the network to the drive.
36 - [M-S Output] xxx1 1111 Configures the I/0 Data to be transferred from the drive to the
controller on the network.

TIP Data In parameters are inputs into the device that come from controller
outputs (for example, data to write to a device parameter). Data Qut
parameters are outputs from the device that go to controller inputs (for
example, data to read a device parameter).
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Controller Tags

When you add the adapter and drive to the I/O configuration (Chapter 4),
RSLogix 5000 software automatically creates generic (non-descriptive) controller
tags for them. In this example program, the following controller tags are used.

Figure 22 - ControlLogix Controller Tags for Drive Generic Profile Example Ladder
Logic Program

M ame i3 | Data Type | Description
||+ My PowerFles_Drive:C ABETHER...
|+ My_PowerFlex_Drive:| AB:ETHER...
||+ My_PowerFlex_Drive:0 AB:ETHER...

You can expand the Input and Output tags to reveal the input and output
configuration.

Figure 23 - ControlLogix Input Image for Drive Generic Profile Example Ladder
Logic Program

Mame & ‘ Data Type | D escription
| |=IMy_PawerFlex_Drive:l SE:ETHER...
|| =My PowerFlex_Drive:l.Data IMNT[12] Input Image
- + by _PowerFlex_Drive:l.Data[d] INT Pad‘»ford
- +-hy_PowerFlex_Drive:l.Data[1] INT Pad‘»ford
- +-hy_PowerFlex_Drive:l.Data[2] INT Logic Status
- +-hy_PowerFlex_Drive:l.Data[3] INT Speed Feedback POWerF'eX 70 Drive
- +-hy_PowerFlex_Drive:l.Data[4] INT D atalink Qut &1 16-b|t Speed Feedback and

+-hy_PowerFlex_Drive:l.Data[5] INT Dratalink Out 22 .

: +-hy_PowerFlex_Drive:l.Data[g] INT D atalink Out B1 Datalmks
- +-hy_PowerFlex_Drive:l Data[7] INT Datalink Out B2
- +-hy_PowerFlex_Drive:l Data[8] INT Datalink Out C1
- +-hy_PowerFlex_Drive:l Data[d] INT Datalink Out C2
- +-hy_PowerFlex_Drive:| Data[10] INT D atalink Out D1
L +-hy_PowerFlex_Drive:l Data[11] INT Doatalink Out D2

Marne 3 | Data Type | Description ‘
| =" My_PoweiFles_Drive:| AB:ETHER...

— My_PowerFlex_Drive:| Data INT[22] Input Image
- + My _PowerFles_Drive:l Data[0] IMNT Pad ‘wiord
L 4 My_PowerFles_Drive: Data[1] INT Pad Ward
- + My _PowerFles_Drive:l Data[2] IMNT Logic Status
L +My_PowerFles_Drive:l. Data[3] INT Not Used
- ~+ My_PowerFles_Drive:l Data[4] INT FeedBack [L5W]
L +My_PowerFles_Drive:l. Data[5] INT Feedback [MS5w)
| + My _PowerFles_Drive: Data[5] INT Datalirk Out &1 [L5W)
- + My _PowerFles_Drive:l Data[7] IMNT Cratalink Cut A1 (5%
L + My _PowerFles_Drive: Data[8] INT Datalirk Out 42 [L5W)
- + My _PowerFles_Drive:l Data[3] IMNT Dratalink Cut A2 [M5W] POWerFleX 7008'89“83 DriVe
+My_PowerFles_Drivel Data[10]  INT Datalink Out BT [LS%W/] .

| % My_PowerFlex Divel Datal11]  INT Datairk Out B1 (MSW) 32-bit Speed Feedback and
| % My PowerFlex_Diivell Data[12]  INT Datalink, Out B2 [L34/] Datalinks
- + My_PowerFles_Drive:l Data[13] INT Dratalink Out B2 [M5'W]
- + My _PowerFles_Drive:l Data[14] IMNT Cratalink Out C1 [LSW)
L + My _PowerFles_Drived Data[15]  INT Datalirk Out C1 (M5
- + My _PowerFles_Drive:l Data[16] IMNT Dratalink Out C2 [LSW]
L +My_PowerFles_Drivel Data[17]  INT Datalink Out C2 [M5'w]
- ~+ My_PowerFles_Drive:l Data[18] INT Dratalink Cut D7 [LSW)
L + My_PowerFles_Drivel Data[19]  INT Datalink Out D1 [M54]
- + My_PowerFles_Drive:l Data[20] INT Dratalink Out D2 [LSW)
- + My PowerFles_Drive:l Data[21] IMNT Cratalink Out D2 (M54
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Figure 24 - ControlLogix Output Image for Drive Generic Profile Example Ladder
Logic Program

Name £ | Diata Type | Description |
_|E My_PowerFles_Drive:0 AB:ETHER. .
—-My_PowerFlex_Drive:0.Data INT[10] Output Image
| + -y PowerFles_Drive: 0.0 ata[0] IMT Logic Command

+-My_PaowerFlex_Drive:0.0ata[1] INT Speed Reference .
| & My _PowerFles DiveODatl2]  INT Datalink In &7 PowerFlex 70 Drive
| My Powerlex Diive:DData[3]  INT Datalink In 4.2 16-bit Speed Reference and
- +-My_PowerFles_Drive: 0.0 ata[4] INT D atalink In B1 Datalinks
| +-My_PawerFlex_Drive: 0.0 atal5] INT D atalink In B2
| +-My_PowerFlex_Drive: 0.0 atal6] INT D atalirk. In C1
- + -y PowerFles_Drive: 0.0 ata[7] IMT Datalink In C2
| +-My_PaowerFlex_Drive: 0.0 ata[8] INT D atalink [n D1
| +-ty_PowerFlex_Drive: 0.0 ata[d] INT D atalink In D2

Marne [ | Data Tppe | D escription
| = My_PowerFlex_Drive:0 AB:ETHER

— My_PowerFlex_Drive:0.0 ata INT[20] Output Image

- + My_PowerFlex_Drive:0.Data[0] INT Logic Commatd
- +/ My PowerFlex_Drive:0.Data[1] INT Not Used
L} + My PowerFlex_Drive:0.Data[2] INT Reference [L5W]
- + My_PowerFlex_Drive:0.Data[3] INT Feference [M5%W]
L + My_PowerFles_Drive:0.Data[4] INT D atalink In &1 [L5W)

+ My_PowerFlex_Drive:0.Data[5] INT Diatalivk, [n &1 (M5 . .
|+ My PowerFlex Dive0.Datals] | INT Datalink In 42 [L5W) PowerFlex700S-Series Drive
| My _PowerFlex Diive:0.Data[7] INT Datalink In A2 M5W) 32-bit Speed Reference and
- +/ ty_PowerFlex_Drive:0.Data[8] INT Dratalink. [n B1 [L5%Ww) Datalinks
L + My_PowerFles_Drive:0.Data[d] INT D atalink In B1 [M5w]

- +/ My_PowerFlex_Drive:0.Data[10]  INT Diatalink [n B2 [L5W)
| + My PowerFlex_Drive:0.Data[11] INT D atalink In B2 [M5'w]
L} + My PowerFlex_Drive:0.Data[12] INT D atalink In C1 [LSWw)
- +/ My_PowerFles_Drive:0.Data[13]  INT Dratalivk, [n C1 (M54
L + My PowerFles_Drive:0.Data[14] INT D atalink In C2 [LSWw)
- +/ My_PowerFlex_Drive:0.Data[15]  INT Datalivk [n C2 (M5
| + My PowerFlex_Drive:0.Data[16] INT D atalink In 0 [LS%)
L} + My PowerFles_Drive:0.0ata[17]  INT D atalink In 01 (M5
- +/ My PowerFlex_Drive:0.Data[18]  INT Dratalivk, [n D2 [LS'Ww]
L} + My PowerFlex_Drive:0.Data[19]  INT D atalink In 02 (M5

Program Tags

To use the Controller tags that are automatically created, you need to create the
following Program tags for this example program.

Figure 25 - ControlLogix Program Tags for Drive Generic Profile Example Ladder
Logic Program

MName i3 | Style | Data Type
| Command_Clear_Faults Decimal BoOL
|| Command_Forward Reverss Decimal EBOOL
| Command Jag Decimal BOOL
(| Command_Start Decimal BOOL
| Command_Stop Decimal BOOL
||+ Speed Feedback Decimal DINT
|+ 5peed_Reference Decimal DIMT
| Status Active Decimal BOOL
| Status At Speed Decimal BOOL
|| Status Faulted Decimal BOOL
| Status Forward Decimal EOOL
| Status Ready Decimal BOOL
|| Status Reverse Decimal EBOOL

For information on speed Reference and Feedback scaling, see PowerFlex 7-Class

Drives on page 85.
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Figure 26 - ControlLogix Example Ladder Logic Program Using a Drive Generic
Profile for Logic Status/Feedback

My_PowerFlex_Drive:|.Data[2].0 Status_Ready
1 E
My_PowerFlex_Drive:l.Data[2].1 Status_Active
1 E
My_PowerFlex_Drive:l.Data[2].3 Status_Forward Povxl/erFleg 70
1E Series Drives
My_PowerFlex_Drive:| Data[2].3 Status_Reverse
IE
i
My_PowerFlex_Drive:| Data[2].7 Status_Faulted
=il
My_PowerFlex_Drive:|.Data[2].8 Status_At_Speed
=li=
MoV PowerFlex 70
Move — .
Source My_PowerFlex_Drive:|.Data[3] Drive Speed
O«
Dest Speed_Feedback Feedback
0e
Cop PowerFlex
Copy File Drive Speed
Source My_PowerFlex_Drive:l.Data[4] Feedback
Dest Speed_Feedback
Length 2
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Figure 27 - ControlLogix Example Ladder Logic Program Using a Drive Generic
Profile for Logic Command/Reference

Command_Stop My_PowerFlex_Drive:0.Data[0].0
JE
Command_Start My_PowerFlex_Drive:0.Data[0].1
JE
Command_Jog My_PowerFlex_Drive O Data[0].2 POV\{EI’HE?( 70
1F Series Drives
Command_Clear_Faults My_PowerFlex_Drive:O Data[0].3
3 F
Command_Forward_Reverse My_PowerFlex_Drive:O.Data[0].4
=li=
Command_Forward_Reverse My_PowerFlex_Drive:0.Data[0].5
J'E
” MOV PowerFlex 70
Viove — .
Source Speed_Reference Drive Speed
Oe
Dest My_PowerFlex_Drive:O.Data[1] Reference
O«
_ COR PowerFlex
Copy File Drive Speed
Source Speed_Reference Reference
Dest My_PowerFlex_Drive: O.Datal2]
Length 2
Example Datalink Data

The Datalink data used in the example program is shown in Figure 28. Note that
to describe the parameters to which the Datalinks are assigned, you may want to
add descriptions to the automatically-created generic controller tags or create a

User Defined Data Types (UDDT).
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Figure 28 - ControlLogix Example Datalinks for Ladder Logic Program Using a Drive

Generic Profile

Name & |Waue €| DataType | Description
__|= My _PawerFlex_Drive:l [...} AB:ETHER...
—I-ty_PoweiFles_Dive:l.Data [aua] INT[1Z] Input Image
| +My_PowerFlex_Drive:l. Data[0] 0/INT Padword
- + My _PowerFlex_Drive:l.Data[1] 0/INT Padword
| +bly_PowerFles_Drive:l.Data[2] 0 IMNT Logic Status
| +My_PowerFlex_Drive:l.Data[3] 0/INT Speed Feedback
- + My _PowerFlex_Drive:l.Data[4] 50 INT Datalink Out &1
| +ty_PowerFlex_Drive:l.Data[5] 50 INT Datalink Dut A2
| +My_PowerFlex_Drive:l.Data[B] 100 INT Datalink Out B
- + My _PowerFlex_Drive:l.Data[7] 1INT Datalink Out B2
| +ty_PowerFlex_Drive:l.Data[g] 200 INT Datalink Out C1
| +My_PowerFlex_Drive:l. Data[3] 300 INT Datalink Dut C2
- + My _PowerFlex_Drive:l.Data[10] 400 INT Datalink. Out D1
| + ty_PowerFlex_Drive:l.Data[11] 500 INT Datalink Out D2
| |I="My_PowerFles_Drive:0 [...} AB:ETHER
—I'My_PowerFlex_Drive:0.Data [...1 INT[1O] Output Image
| +bly_PowerFles_Drive:0.0ata0] 0 IMNT Logic Command
- + My_PowerFlex_Drive:0.Datal1] 0/INT Speed Reference
- + My _PowerFlex_Drive:0.Data2] 50 INT Datalirk. In 41
| + ty_PowerFlex_Drive:0.Data(3] 50 INT Datalink In &2
| +My_PowerFlex_Drive:0.Datal4] 100 INT Datalink In B1
- + My _PowerFlex_Drive:0.Data(5] 1INT Datalink In B2
| + ty_PowerFlex_Drive:0.Data(6] 200 INT Datalink In C1
| +My_PowerFlex_Drive:0.Datal?] 300 INT Datalink In C2
- + My _PowerFlex_Drive:0.Data(B] 400 INT Datalirk. In D1
| +-My_PowerFlex_Drive:0.Data[3] 500 IMT Datalink InD2
Name & |Wale €| DataType | Desoiption,
|__|= My _PaowerFles_Drive:l [...} ABETHER..
— My_PowerFlex_Drive:l. Data [...} INT[2Z] Input Image
L + My_PaowerFlex_Drive:l. Data(0] 0/INT Pad'ward
L My_PowerFles_Diiverl Data[1] Pad Word
L tdy_PawerFlex_Drive:l.Diata[2] Logic Status
L My_PowerFles_Driverl Data[3] Mot Used
Ll My_PowerFles_Drive:l.Datal4] Feedback [LSWwW]
My_PaowerFlex_Drive:l.Data[5] Feedback [M5W]

My_PowerFlex_Drive:l.Datalg]
My_PaowerFles_Drive:l.Data[7]
ty_PowerFles_Drivel Data[8]
My_PaowerFles_Drive:l.Data[3]
ty_PowerFles_Drivel Data[10]
tdy_PawerFlex_Drive:l.Data[11]

o 3 3 o R e o e e e [

L My_PawerFles_Diive: Data[12] 0/INT
L tdy_PawerFlex_Drive:l.Data[13] 0 INT
L My_PowerFles_Drive:l Data[14] 0 INT
L tdy_PawerFlex_Drive:l.Data[15] 0 INT
L My_PowerFles_Diive:l Data[16] 0 INT
Ll My_PowerFles_Drive:l.Data[17] 0 INT
L tdy_PowerFles_Drive:l.Data[18] 0/INT
Ll My_PowerFles_Drive:l.Data[19] 0 INT
L My_PawerFles_Drive:l.Data[20] 0/INT
- My_PowerFles_Driverl Datal21] 0INT
|__|= My_PaoweFlex_Drive:0 [...} ABETHER..
— by PowerFlex Drive:0.Data {...} INT[20]

L + My_PowerFlex_Drive:0.Data[0] 0 INT
- + by PowerFlex_Drive:0.Data[1] a/INT
L + My_PowerFlex_Drive:0.Data[2] 25000 INT
L + My_PowerFles_Drive:0.Data[3] o|INT
L + My_PowerFlex_Drive:0.Data[4] INT
L +/ My_PowerFles_Drive:0.Data[5] 0 lINT
L + My_PowerFlex_Drive:0.Data[E] 0 INT
L] +/ My_PowerFles_Drive:0. Data[7] INT
- + by PowerFler Drive:0.Data[8] INT
| + My_PoweirFlex_Drive:0.Data[9] INT
- + My _PowerFler Drive:0.Data[10] 0/INT

+ My_PowerFles_Drive:0.Data[11] 0 INT

Datalink Out 41 [LSwW)
Datalink Out &1 [MS'W)
Datalink Dut A2 [L5Ww]
Datalink Out 42 [MS'W)
Datalink Out BT (LS
Diatalink Out B1 (M5!
Datalink Dut B2 (LS
i
(
i
(

Diatalink Out B2 (M5!
Datalink Out C1 (LW
Diatalink Out C1 [MShw)
Datalink Out C2 (L5
Datalink Out C2 [MShw)
Datalink Out D1 [L5W)
Datalink Out D7 [MSW]
Datalink Out D2 [L5W)
Datalink Out D2 [M5W]

Output Image:

Logic Command

Mot Used

Rieference (L5Ww)

Reference MSw)

Diatalink [n A1 [LSW)

Datalink In 41 (MSW/)

Datalink [n A2 [LSW)

Datalink In 42 (MSW/)

Datalink n B1 [LSW]
i
(
i

Datalirk In B1 M5
Datalink In B2 [LSWw]
Datalink In B2 (MS'W)

R

PowerFlex 70 Drive

PowerFlex 700S-Series Drive

For PowerFlex 7-Class drives, the scaling may need to be multiplied by 10 or 100,
depending on the parameter. For more information, see Using Datalinks on

page 86.
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MicroLogix 1100/1400 Drive and Adapter Parameter Settings
Controller Example

The following drive and adapter settings were used for the example ladder logic
program in this section.

Device Parameter Value Description
PowerFlex 70 EC | 90 - [Speed Ref A Sel] | 22 (DPI Port 5) Assigns 20-COMM-ER to be used for the Reference.
Drive 300 - [Data In A1] 140 Points to Par. 140 - [Accel Time 1]
301 - [Data In A2] 142 Points to Par. 142 - [Decel Time 1]
302 - [Data In B1] 100 Points to Par. 100 - [Jog Speed]
303 - [Data In B2] 155 Points to Par. 155 - [Stop Mode A]
304 - [Data In C1] 101 Points to Par. 101 - [Preset Speed 1]
305 - [Data In C2] 102 Points to Par. 102 - [Preset Speed 2]
306 - [Data In D1] 103 Points to Par. 103 - [Preset Speed 3]
307 - [Data In D2] 104 Points to Par. 104 - [Preset Speed 4]
310 - [Data Out A1] 140 Points to Par. 140 - [Accel Time 1]
311 - [Data Out A2] 142 Points to Par. 142 - [Decel Time 1]
312 - [Data Out B1] 100 Points to Par. 100 - [Jog Speed]
313 - [Data Out B2] 155 Points to Par. 155 - [Stop Mode A]
314 - [Data Out C1] 101 Points to Par. 101 - [Preset Speed 1]
315 - [Data Out C2] 102 Points to Par. 102 - [Preset Speed 2]
316 - [Data Out D1] 103 Points to Par. 103 - [Preset Speed 3]
317 - [Data Out D2] 104 Points to Par. 104 - [Preset Speed 4]
20-COMM-ER 04 - [IP Addr Cfg 1] 10.91.100.79 IP address for the adapter.
Adapter :
07 - [IP Addr Cfg 4]
08 - [Subnet Cfg 1] 255.255.248.0 Subnet mask for the adapter.
11 - [Subnet Cfg 4]
23 - [DPI 1/0 Cfg] xxx1 1111 Enables Cmd/Ref and Datalinks A...D.
35 - [M-S Input] xxx1 1111 Configures the 1/0 Data to be transferred from the controller
on the network to the drive.
36 - [M-S Output] xxx1 1111 Configures the I/0 Data to be transferred from the drive to
the controller on the network.

TIP  Data In parameters are inputs into the drive that come from controller outputs (for
example, data to write to a drive parameter). Data Out parameters are outputs from the
drive that go to controller inputs (for example, data to read a drive parameter).

TIP When using a drive that has 16-bit Datalinks (PowerFlex 70, PowerFlex 700, and
PowerFlex 700H drives) to transfer a 32-bit parameter, two contiguous drive Datalink
parameters (for example, Data Out A1/A2, B1/B2, etc.) are required. To determine if a
parameter is a 32-bit parameter, see the Parameter section in the drive documentation
and look for a %% symbol in the ‘No." column. (All parameters in PowerFlex 700 Series B
drives are 32-bit parameters.) For example, parameter 3 - [Output Current] in a PowerFlex
70 EC drive is a 32-bit parameter. When using a drive that has 32-bit Datalinks (PowerFlex
700 VC and PowerFlex 700S), only one drive Datalink parameter is required to transfer any
parameter.

96 Rockwell Automation Publication 20COMM-UMO15B-EN-P - July 2013



Usingthe I/0  Chapter 5

Understanding Controller Data Table Addresses

Because MicroLogix 1100/1400 controllers are 16-bit platforms and are used
with the 32-bit 20-COMM-ER adapter, the data will be transposed from the
least-significant word (LSW) to the most-significant word (MSW) in the
controller.

When the I/O was configured (Chapter 4), an available data table address (N20)
was used. Figure 29 shows the entire data file address structure for this example.

Figure 29 - Data File Table for Example Ladder Logic Program

7= Data File N20 (dec)

K| 2
[N2m:D | Radi | Decimal -
Symbol: | | Calumns: (10 *

Desc: | |

M20 ﬂ Froperties Usage Help

Important: The N20:0 data table address in this example is used to set a
control timeout value (in seconds) which determines how long
it will take the adapter to detect a communication loss. Enter a
valid value (1...32767) for N20:0. A value of zero (0) is not
valid, because it disables the timeout and al 1/0 connections
(Logic Command/Status, Reference/Feedback, and Datalinks)
intended for the drive will not execute. A timeout value of
5...20 seconds is recommended.

Depending on the drive you are using, Table 11, Table 12, Table 13, or Table 14
show the I/O definitions as they relate to the N20 data table (Figure 29) being

used in this example.

When using PowerFlex 70 or 70 EC, PowerFlex 700, PowerFlex 700V C drives, or
SMC Flex controllers—which all contain INT (16-bit format) data types, you
will read from and write to the MSW data table address in the controller.

When using PowerFlex 700 VC drives or SMC-50 controllers, which contain
DINT (32-bit format) data types, you will read from and write to the LSW data
table address in the controller.

When using PowerFlex 7008 drives, which contain both DINT (32-bit format)
and REAL (floating point format) data types, you will always read from and write
to the LSW data table address in the controller first. Then if the data value
exceeds 16 bits, the remaining value will be in the MSW data table address.
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Table 11 - Controller Data Table Addresses for PowerFlex 70/70 EC,
PowerFlex 700 Drives, and SMC Flex Controllers

Data Table Address | Description

N20:1 Logic Status (see Appendix D)

N20:2 Reserved

N20:3 Speed Feedback

N20:4 Value of parameter assigned to Parameter 310 [Data Out A1] LSW
N20:5 Value of parameter assigned to Parameter 310 [Data Out A1] MSW
N20:6 Value of parameter assigned to Parameter 311 [Data Out A2] LSW
N20:7 Value of parameter assigned to Parameter 311 [Data Out A2] MSW
N20:8 Value of parameter assigned to Parameter 312 [Data Out B1] LSW
N20:9 Value of parameter assigned to Parameter 312 [Data Out B1] MSW
N20:10 Value of parameter assigned to Parameter 313 [Data Out B2] LSW
N20:11 Value of parameter assigned to Parameter 313 [Data Out B2] MSW
N20:12 Value of parameter assigned to Parameter 314 [Data Out C1] LSW
N20:13 Value of parameter assigned to Parameter 314 [Data Out C1] MSW
N20:14 Value of parameter assigned to Parameter 315 [Data Out C2] LSW
N20:15 Value of parameter assigned to Parameter 315 [Data Out C2] MSW
N20:16 Value of parameter assigned to Parameter 316 [Data Out D1] LSW
N20:17 Value of parameter assigned to Parameter 316 [Data Out D1] MSW
N20:18 Value of parameter assigned to Parameter 317 [Data Out D2] LSW
N20:19 Value of parameter assigned to Parameter 317 [Data Out D2] MSW
N20:20 Logic Command (see Appendix D)

N20:21 Reserved

N20:22 Speed Reference

N20:23 Value of parameter assigned to Parameter 300 [Data In A1] LSW
N20:24 Value of parameter assigned to Parameter 300 [Data In A1] MSW
N20:25 Value of parameter assigned to Parameter 301 [Data In A2] LSW
N20:26 Value of parameter assigned to Parameter 301 [Data In A2] MSW
N20:27 Value of parameter assigned to Parameter 302 [Data In B1] LSW
N20:28 Value of parameter assigned to Parameter 302 [Data In B1] MSW
N20:29 Value of parameter assigned to Parameter 303 [Data In B2] LSW
N20:30 Value of parameter assigned to Parameter 303 [Data In B2] MSW
N20:31 Value of parameter assigned to Parameter 304 [Data In C1] LSW
N20:32 Value of parameter assigned to Parameter 304 [Data In C1] MSW
N20:33 Value of parameter assigned to Parameter 305 [Data In C2] LSW
N20:34 Value of parameter assigned to Parameter 305 [Data In C2] MSW
N20:35 Value of parameter assigned to Parameter 306 [Data In D1] LSW
N20:36 Value of parameter assigned to Parameter 306 [Data In D1] MSW
N20:37 Value of parameter assigned to Parameter 307 [Data In D2] LSW
N20:38 Value of parameter assigned to Parameter 307 [Data In D2] MSW
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Table 12 - Controller Data Table Addresses for PowerFlex 700 VC Drives and SMC-
50 Controllers

Data Table Address | Description

N20:1 Logic Status (see Appendix D)

N20:2 Reserved

N20:3 Speed Feedback

N20:4 Value of parameter assigned to Parameter 310 [Data Out A1] LSW
N20:5 Value of parameter assigned to Parameter 310 [Data Out A1] MSW
N20:6 Value of parameter assigned to Parameter 311 [Data Out A2] LSW
N20:7 Value of parameter assigned to Parameter 311 [Data Out A2] MSW
N20:8 Value of parameter assigned to Parameter 312 [Data Out B1] LSW
N20:9 Value of parameter assigned to Parameter 312 [Data Out B1] MSW
N20:10 Value of parameter assigned to Parameter 313 [Data Out B2] LSW
N20:11 Value of parameter assigned to Parameter 313 [Data Out B2] MSW
N20:12 Value of parameter assigned to Parameter 314 [Data Out C1] LSW
N20:13 Value of parameter assigned to Parameter 314 [Data Out C1] MSW
N20:14 Value of parameter assigned to Parameter 315 [Data Out C2] LSW
N20:15 Value of parameter assigned to Parameter 315 [Data Out C2] MSW
N20:16 Value of parameter assigned to Parameter 316 [Data Out D1] LSW
N20:17 Value of parameter assigned to Parameter 316 [Data Out D1] MSW
N20:18 Value of parameter assigned to Parameter 317 [Data Out D2] LSW
N20:19 Value of parameter assigned to Parameter 317 [Data Out D2] MSW
N20:20 Logic Command (see Appendix D)

N20:21 Reserved

N20:22 Speed Reference

N20:23 Value of parameter assigned to Parameter 300 [Data In A1] LSW
N20:24 Value of parameter assigned to Parameter 300 [Data In A1] MSW
N20:25 Value of parameter assigned to Parameter 301 [Data In A2] LSW
N20:26 Value of parameter assigned to Parameter 301 [Data In A2] MSW
N20:27 Value of parameter assigned to Parameter 302 [Data In B1] LSW
N20:28 Value of parameter assigned to Parameter 302 [Data In B1] MSW
N20:29 Value of parameter assigned to Parameter 303 [Data In B2] LSW
N20:30 Value of parameter assigned to Parameter 303 [Data In B2] MSW
N20:31 Value of parameter assigned to Parameter 304 [Data In C1] LSW
N20:32 Value of parameter assigned to Parameter 304 [Data In C1] MSW
N20:33 Value of parameter assigned to Parameter 305 [Data In C2] LSW
N20:34 Value of parameter assigned to Parameter 305 [Data In C2] MSW
N20:35 Value of parameter assigned to Parameter 306 [Data In D1] LSW
N20:36 Value of parameter assigned to Parameter 306 [Data In D1] MSW
N20:37 Value of parameter assigned to Parameter 307 [Data In D2] LSW
N20:38 Value of parameter assigned to Parameter 307 [Data In D2] MSW
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Table 13 - Controller Data Table Addresses for PowerFlex 700S Drives with Phase |

Control
Data Table Address | Description
N20:1 Logic Status (see Appendix D)
N20:2 Speed Feedback LSW
N20:3 Speed Feedback MSW
N20:4 Value of parameter assigned to Parameter 724/725 [Data Out A1] LSW
N20:5 Value of parameter assigned to Parameter 724/725 [Data Out A1] MSW
N20:6 Value of parameter assigned to Parameter 726/727 [Data Out A2] LSW
N20:7 Value of parameter assigned to Parameter 726/727 [Data Out A2] MSW
N20:8 Value of parameter assigned to Parameter 728/729 [Data Out B1] LSW
N20:9 Value of parameter assigned to Parameter 728/729 [Data Out B1] MSW
N20:10 Value of parameter assigned to Parameter 730/731 [Data Out B2] LSW
N20:11 Value of parameter assigned to Parameter 730/731 [Data Out B2] MSW
N20:12 Value of parameter assigned to Parameter 732/733 [Data Out C1] LSW
N20:13 Value of parameter assigned to Parameter 732/733 [Data Out C1] MSW
N20:14 Value of parameter assigned to Parameter 734/735 [Data Out C2] LSW
N20:15 Value of parameter assigned to Parameter 734/735 [Data Out C2] MSW
N20:16 Value of parameter assigned to Parameter 736/737 [Data Out D1] LSW
N20:17 Value of parameter assigned to Parameter 736/737 [Data Out D1] MSW
N20:18 Value of parameter assigned to Parameter 738/739 [Data Out D2] LSW
N20:19 Value of parameter assigned to Parameter 738/739 [Data Out D2] MSW
N20:20 Logic Command (see Appendix D)
N20:21 Speed Reference LSW
N20:22 Speed Reference MSW
N20:23 Value of parameter assigned to Parameter 707/708 [Data In A1] LSW
N20:24 Value of parameter assigned to Parameter 707/708 [Data In A1] MSW
N20:25 Value of parameter assigned to Parameter 709/710 [Data In A2] LSW
N20:26 Value of parameter assigned to Parameter 709/710 [Data In A2] MSW
N20:27 Value of parameter assigned to Parameter 711/712 [Data In B1] LSW
N20:28 Value of parameter assigned to Parameter 711/712 [Data In B1] MSW
N20:29 Value of parameter assigned to Parameter 713/714 [Data In B2] LSW
N20:30 Value of parameter assigned to Parameter 713/714 [Data In B2] MSW
N20:31 Value of parameter assigned to Parameter 715/716 [Data In C1] LSW
N20:32 Value of parameter assigned to Parameter 715/716 [Data In C1] MSW
N20:33 Value of parameter assigned to Parameter 717/718 [Data In C2] LSW
N20:34 Value of parameter assigned to Parameter 717/718 [Data In C2] MSW
N20:35 Value of parameter assigned to Parameter 719/720 [Data In D1] LSW
N20:36 Value of parameter assigned to Parameter 719/720 [Data In D1] MSW
N20:37 Value of parameter assigned to Parameter 721/722 [Data In D2] LSW
N20:38 Value of parameter assigned to Parameter 721/722 [Data In D2] MSW
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Table 14 - Controller Data Table Addresses for PowerFlex 700S Drives with Phase Il

Control
Data Table Address | Description
N20:1 Logic Status (see Appendix D)
N20:2 Speed Feedback LSW
N20:3 Speed Feedback MSW
N20:4 Value of parameter assigned to Parameter 660 [DPI Data Out A1] LSW
N20:5 Value of parameter assigned to Parameter 660 [DPI Data Out A1] MSW
N20:6 Value of parameter assigned to Parameter 661 [DPI Data Out A2] LSW
N20:7 Value of parameter assigned to Parameter 661 [DPI Data Out A2] MSW
N20:8 Value of parameter assigned to Parameter 662 [DPI Data Out B1] LSW
N20:9 Value of parameter assigned to Parameter 662 [DP| Data Out B1] MSW
N20:10 Value of parameter assigned to Parameter 663 [DPI Data Out B2] LSW
N20:11 Value of parameter assigned to Parameter 663 [DPI Data Out B2] MSW
N20:12 Value of parameter assigned to Parameter 664 [DP| Data Out C1] LSW
N20:13 Value of parameter assigned to Parameter 664 [DPI Data Out C1] MSW
N20:14 Value of parameter assigned to Parameter 665 [DPI Data Out C2] LSW
N20:15 Value of parameter assigned to Parameter 665 [DPI Data Out C2] MSW
N20:16 Value of parameter assigned to Parameter 666 [DPI Data Out D1] LSW
N20:17 Value of parameter assigned to Parameter 666 [DPI Data Out D1] MSW
N20:18 Value of parameter assigned to Parameter 667 [DP| Data Out D2] LSW
N20:19 Value of parameter assigned to Parameter 667 [DPI Data Out D2] MSW
N20:20 Logic Command (see Appendix D)
N20:21 Speed Reference LSW
N20:22 Speed Reference MSW
N20:23 Value of parameter assigned to Parameter 651 [DPI Data In A1] LSW
N20:24 Value of parameter assigned to Parameter 651 [DPI Data In A1] MSW
N20:25 Value of parameter assigned to Parameter 652 [DPI| Data In A2] LSW
N20:26 Value of parameter assigned to Parameter 652 [DPI Data In A2] MSW
N20:27 Value of parameter assigned to Parameter 653 [DPI Data In B1] LSW
N20:28 Value of parameter assigned to Parameter 653 [DPI Data In B1] MSW
N20:29 Value of parameter assigned to Parameter 654 [DPI Data In B2] LSW
N20:30 Value of parameter assigned to Parameter 654 [DPI Data In B2] MSW
N20:31 Value of parameter assigned to Parameter 655 [DPI Data In C1] LSW
N20:32 Value of parameter assigned to Parameter 655 [DPI Data In C1] MSW
N20:33 Value of parameter assigned to Parameter 656 [DPI Data In C2] LSW
N20:34 Value of parameter assigned to Parameter 656 [DPI Data In C2] MSW
N20:35 Value of parameter assigned to Parameter 657 [DPI Data In D1] LSW
N20:36 Value of parameter assigned to Parameter 657 [DPI Data In D1] MSW
N20:37 Value of parameter assigned to Parameter 658 [DPI Data In D2] LSW
N20:38 Value of parameter assigned to Parameter 658 [DPI Data In D2] MSW

You can use the controller data table addresses to directly control and monitor the
drive without creating any ladder logic program. However, if you intend to use
Human Machine Interface devices (PanelView, and so forth) to operate the drive
and view its status, you will need to create descriptive controller data table

addresses (Table 15 and Table 16) and a ladder logic program that will pass that
data to the data table addresses used for messaging.
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Table 15 - Controller and Program Data Table Address Descriptions for Example

Logic Status/Feedback Ladder Logic Program

Description Table Adress,  Deserpton Table Address
Drive Ready N20:1/0 Status Ready B3:1/0
Drive Active N20:1/1 Status Active B3:1/1
Actual Direction (XIO) N20:1/3 Status Forward B3:1/3
Actual Direction (XIC) N20:1/3 Status Reverse B3:1/4
Drive Faulted N20:1/7 Status Faulted B3:1/7
Drive At Speed N20:1/8 Status At Speed B3:1/8
Speed Feedback N20:3 Speed Feedback B30:3

Table 16 - Program and Controller Data Table Address Descriptions for Example
Logic Command/Reference Ladder Logic Program

Descripion TabeAddess 0PN g s
Command Stop B3:20/0 Drive Stop N20:20/0
Command Start B3:20/1 Drive Start N20:20/1
Command Jog B3:20/2 Drive Jog N20:20/2
Command Clear Faults B3:20/3 Drive Clear Faults N20:20/3
Command Forward Reverse (XIO) | B3:20/4 Drive Forward N20:20/4
Command Forward Reverse (XIC) | B3:20/4 Drive Reverse N20:20/5
Speed Reference N30:22 Speed Reference N20:22

An example ladder logic program that uses these descriptive controller data table
addresses and passes their data to the descriptive program data table addresses is
shown in Figure 30, Figure 31, Figure 32, and Figure 33.

Figure 30 - MicroLogix 1100/1400 Example Ladder Logic Program for Logic Status

1

Actual Direction

Drive Ready Status Ready
N20:1 B3l
1C E
JC

0 0

Drive Active Status Active
N20:1 B3:1
TE N
1

1

Status Forward

N20:1 B3l
1C N
JC
3 3
Actual Direction Status Reverse
N20:1 B3:1
:\,/i ™y
3 4
Drive Faulted Status Faulted
N20:1 B3l
1F R
JC

7

Drive At Speed
N20:1
1
1 C

7

Status At Speed
B3:1
N

8
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Figure 31 - MicroLogix 1100/1400 Example Ladder Logic Program for Speed

Feedback
D{i\'a 3?296 Feadback
High Wort PowerFlex 70
Drive Speed
Feedback

Figure 32 - MicroLogix 1100/1400 Example Ladder Logic Program for Logic

Command
Command Stop Drive Stop
B3:20 N20:20
1 r © Yy
1
0 0
Command Start Drive Start
B3:20 N20:20
1 E oy
1
1 1
Command Jog Drive Jog
B3:20 N20:20
1r Y
) 5 PowerFlex 70
Drives
Command Clear Faults Drive Clear Faults
B3:20 N20:20
1 E
JC
3 3
Command Forward
Reverse Drive Forward
B3:20 N20:20
1

4

Command Forward

Reverse Drive Reverse
B3:20 N20:20
M ™y
4 5

Figure 33 - MicroLogix 1100/1400 Example Ladder Logic Program for Speed

Reference
Drive Spasd
Faference
Hign Wout PowerFlex 70
Drive Speed
Reference
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Chapter 6

Using Explicit Messaging

This chapter provides information and examples that explain how to use Explicit
Messaging to configure and monitor the adapter and connected PowerFlex 7-

Class drive or SMC.
Topic Page
About Explicit Messaging 106
Performing Explicit Messages 106
ControlLogix Controller Examples 10
MicroLogix 1100/1400 Controller Examples 124

this publication are intended solely for purposes of example. There are
many variables and requirements with any application. Rockwell
Automation, Inc. does not assume responsibility or liability (to include
intellectual property liability) for actual use of the examples shown in this
publication.

2 ATTENTION: Risk of equipment damage exists. If Explicit Messages are

2 ATTENTION: Risk of injury or equipment damage exists. The examples in

programmed to write parameter data to Nonvolatile Storage (NVS)
frequently, the NVS will quickly exceed its life cycle and cause the drive to
malfunction. Do not create a program that frequently uses Explicit
Messages to write parameter data to NVS. Datalinks do not write to NVS
and should be used for frequently changed parameters.

See Chapter 5 for information about the I/O Image, using Logic Command/
Status, Reference/Feedback, and Datalinks.
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Chapter 6 Using Explicit Messaging

About Exp||c|t Messag I ng Explicit Messaging is used to transfer data that does not require continuous

Performing Explicit
Messages

106

updates. With Explicit Messaging, you can configure and monitor a slave device’s
parameters on the network.

Important: When an explicit message is performed, by default no
connection is made sinceit isan ‘unconnected’ message. When
timing of the message transaction isimportant, you can create a
dedicated message connection between the controller and drive
by checking the * Connected’ box on the Communications tab
message configuration screen during message setup. These
message connections are in addition to the 1/O connection.
However, the trade off for more message connectionsis
decreased network performance. If your application cannot
tolerate this, do not check the * Connected’ box, which is
recommended.

Important: PowerFlex 7-Class drives have explicit messaging limitations.
Table 17 shows the EtherNet/I P Object Class code
compatibilities for these drives.

Table 17 - Explicit Messaging Class Code Compatibility with Drives

EtherNet/IP Object PowerFlex Explicit Messaging Function
Class Code 7-Class Drives

Parameter Object OXOF | Yes Single parameter reads/writes
DPI Parameter Object | Yes Single and scattered parameter
0x93 reads/writes

There are five basic events in the Explicit Messaging process. The details of each
step will vary depending on the type of controller being used. See the
documentation for your controller.

Important: There must be arequest message and a response message for all
Explicit Messages, whether you are reading or writing data.
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Figure 34 - Explicit Message Process

o Set up and send Explicit
Message Request
Complete Explicit ‘A ;
© " Vesage e
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| —]
o Retrieve Explicit [~~~ Al mESS=
Message Response (2] i f
i S Ethernet
= =2 Switch
Event | Description
You format the required data and set up the ladder logic program to send an Explicit
Message request to the scanner or bridge module (download).
) The scanner or bridge module transmits the Explicit Message Request to the slave device
over the network.
L) The slave device transmits the Explicit Message Response back to the scanner. The data is
stored in the scanner buffer.
(4] The controller retrieves the